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Abstract

Collective privacy loss becomes a colossal problem, an emergency for personal freedoms and
democracy. But, are we prepared to handle personal data as scarce resource and collectively
share data under the doctrine: as little as possible, as much as necessary? We hypothesize a
significant privacy recovery if a population of individuals, the data collective, coordinates to
share minimum data for running online services with the required quality. Here we show how to
automate and scale-up complex collective arrangements for privacy recovery using decentralized
artificial intelligence. For this, we compare for first time attitudinal, intrinsic, rewarded and
coordinated data sharing in a rigorous living-lab experiment of high realism involving >27,000
data-sharing choices. Using causal inference and cluster analysis, we differentiate criteria pre-
dicting privacy and five key data-sharing behaviors. Strikingly, data-sharing coordination proves
to be a win-win for all: remarkable privacy recovery for people with evident costs reduction for
service providers.

1 Introduction
Control over sharing or giving access to personal data from pervasive personal devices, such as
smartphones, turns out to be complex, involving critical decisions for privacy with impact on so-
ciety. How to run data-intensive online services to improve everyday life without compromising
personal values and freedoms? In practice, the data-sharing doctrine ‘as little as possible, as much
as necessary’ has not yet found a systematic and scalable applicability. The quality of online services
is often a result of collective data-sharing decisions made by individuals consuming these services,
for instance, traffic predictions using mobility data [1, 2]. To achieve a minimum quality of service
for a population of individuals while maximizing their privacy, a collective arrangement (i.e. coordi-
nation) of their data-sharing decisions is required to minimize both excessive and insufficient levels

1

ar
X

iv
:2

30
1.

05
99

5v
1 

 [
cs

.A
I]

  1
5 

Ja
n 

20
23



of data sharing [3, 4, 5]. Although a recent survey finds a 58% of individuals willing to balance
data sharing case-by-case [6], it proves cognitively and computationally hard to achieve [7] even
when using state-of-the-art privacy preservation techniques such as differential privacy [8, 9] and
k-anonymization [5, 10]. The absence, failure or inefficiency in this coordination exhibit a tragedy
of the (data sharing) commons, making privacy easier to compromise than quality of service. As
a result, studies show that 90% of individuals tend to give up privacy of their data, often without
any added value [7], although 76% intend to protect it [11, 12]. This insight is fundamental to
several studies on the willingness to accept rewards for giving up privacy or willingness to pay a cost
for preserving privacy [7, 13, 14, 15, 16]. Implications of giving up excessive personal data include
energy-intensive and expensive data centers with unprocessed data growing faster than Moore’s law
predictions, stress and anxiety, algorithmic biases, discrimination, censorship and influence of elec-
tion results [17, 18, 19, 7, 20, 21]. Therefore, establishing a coordinated data sharing is a collective
action to recover privacy with a immense impact for the environment, health, society and democracy.

How to make coordinated data sharing feasible. While privacy control is found essential
for 82% of individuals, so is convenience for 63% [6, 22]. The computational and communication
load to coordinate data-sharing decisions at scale is overwhelming for humans alone. Instead, a scal-
able decision support can be provided by interactive personal assistants using cooperative artificial
intelligence (AI) to cope with such complexity [23]. These assistants can run on (mobile) devices
of individuals who form a community (i.e. data collective) to consume an online service that relies
on data they share in a coordinated way. In practice, the remote personal assistants interact in the
background to calculate how much and what data to share, to which data collector and for what
purpose (see Fig. 1 and 2). These multi-agent interactions and calculations self-organize into fully
decentralized unsupervised learning process [24] that optimizes data-sharing efficiency: maximizing
quality of service and minimizing privacy cost. Compared to other AI approaches for personal-
ized privacy assistants [25] applied to legal document analytics [26] and pervasive devices [27], this
decision-support system is itself privacy-preserving and does not rely on any centralized third party.
Therefore, the interactive personal assistants are trustworthy by design to serve as the privacy en-
abler of the data collective. This comes in stark contrast to the mainstream use of supervised AI
algorithms that often require large concentrations of sensitive personal data for training [28, 21, 17].
The proposed decision-support system can also operate as a trustworthy collective access control to
local data by federated learning algorithms to train models in a privacy-preserving way [29, 28].

Hypotheses for understanding data-sharing conditions. The overarching aim of this
study is to assess the capacity of this novel AI-based system to steer the data collective into more
efficient and privacy-preserving trajectories for data sharing. Fig. 1 illustrates the main studied
hypotheses. These hypotheses are formalized into four experimental conditions for data sharing
under repeated measures. They are rigorously compared with each other under high realism in
a novel living-lab experiment, see Section 4.1, Fig. 8 and 9. Over 27,403 high-quality records of
data-sharing decisions are collected by a novel platform developed for this purpose, see Section 4.2.
It encompasses a smartphone app, a server to collect experimental data as well as a web portal
with which the involved data collectors can access the shared data according to the privileges that
participants give. The four studied experimental conditions shown in Fig. 2 are the following:
1. Attitudinal data sharing assesses how privacy-sensitive individuals perceive each of the
3 criteria · 4 elements/criterion = 12 data-sharing elements, see Table 4, Questions B.9 to B.12
in Supplementary Information (SI).
2. Intrinsic data sharing assesses actual decisions made for voluntarily data sharing (without
rewards) in a complete factorial design of 4 sensors · 4 collectors · 4 contexts = 64 data-sharing
scenarios.
3. Rewarded data sharing introduces a privacy-reward balance that individuals initially influence
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Figure 1: Tragedies of data-sharing commons showing a coordination deficiency. We
hypothesize that while individuals may rationally intend to share a sufficient level of data, they
end sharing intrinsically an insufficient level. If rewarded, data sharing is excessive with significant
privacy loss. When coordination is introduced via a trustworthy AI-based decision-support system,
significant privacy is recovered while achieving the desired quality of service. These studied hypothe-
ses are formalized into four data-sharing conditions: (i) attitudinal, (ii) intrinsic, (iii) rewarded and
(iv) coordinated.

Sensor Type Data Collector Context

Global Position System [gps]

Noise [noi]

Accelerometer [acc]

Light [lig]

Corporation [cor]

Non-gov. organization [ngo]

Educational Institute [edu]

Gov. Organization [gov]

Social networking [soc]

Environment [env]

Transportation [tra]

Health [hea]

Data-sharing ScenariosDa
ta

-s
ha

rin
g 

El
em

en
ts

Data-sharing Criteria

Figure 2: The studied 4x4x4 full factorial design for smartphone data sharing. It consists
of 3 data-sharing criteria, each with 4 elements creating 64 combinations of data-sharing scenarios.
Each scenario involves a choice of what data to share, to which data collector and for what purpose.
The choice of the exact sensors, collectors and contexts is outlined in Section 3.2 of SI. The labels
are used in the plots of this paper.

with their choices over the 64 data-sharing scenarios (see Fig. 9a). The balance can be further
calibrated by making on-demand and repeated (unlimited within 24 hours) choices among the 64
data-sharing scenarios retrieved automatically. Each retrieved scenario is calculated to improve the
individual’s choice: privacy or rewards, see Fig. 9b. To account for threats to validity and trace any
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order effects, this experimental condition is repeated twice (2 · 24 hours) by clearing the privacy-
reward balance and collecting new data from sensors (Fig. 8). To challenge privacy preservation,
the rewards are personalized by inflating and deflating the amounts based on each individual’s
privacy perception derived from attitudinal data sharing, see Section 1 in SI. This design choice is
also expected to engage participants more effectively by rewarding the data-sharing scenarios fairly,
according to their personal values [7], while discouraging dropouts.
4. Coordinated data sharing relies on the AI-based personal assistants. They use the intrinsic
and rewarded data-sharing levels as discrete options to choose from. Each assistant makes an
optimized choice among these that recovers the collective privacy loss of the rewarded data sharing,
while reducing the mismatch (discrepancy/fitness measure) between the shared and required data.
This quality-of-service indicator finds general applicability in adaptive sensor selection and flexible
data fusion for several smart city and industrial applications [30, 31, 32]. Matching can also be
applied by a coordinated data collective to preserve in a bottom-up way k-anonymity, i.e. no more
than k individuals share any combination of personal data [5, 10, 33].

Smartphone sensor data play a pivotal role on privacy. This paper studies sharing of
smartphone sensor data with five discrete choices to choose from (uniform sampling of 100% to 0%
of sensor data with a step of 25%), see Fig. 9b. These choices are applied to the total sensor data
collected with a fixed frequency of 30 sec (100% of data). The study of smartphone sensor data is
particularly impactful for both privacy and quality of online services. Sensor fusion has a paramount
role in applications of smart homes, grids and transportation [30]. There is evidence that smartphone
app developers delegate privacy to end-users as the former face challenges in providing privacy
solutions at the design and implementation phase [34]. In practice though, it is the powerful data
intermediaries that leverage the terms of data-sharing agreements [6, 35]. Sharing smartphone sensor
data can be regulated via privacy-protection mechanisms with a natural utility-driven interpretation
(buy-sell) such as differential privacy [4]. However, the symbiotic relationship of individuals with
their smartphones, capturing high-dimensional and diverse sensor data, makes sensitive information
inference possible [36, 28]. For instance, four apps [35] or spatio-temporal points [1] are enough to
identify 91.2% and 95% of individuals.

A novel approach to understanding data-sharing decisions. The performed living-lab
experiment is the first of its kind: (i) It brings together all four data-sharing conditions for compar-
ison, including the novel one of coordinated data sharing. This is distinguished from earlier survey
studies and empirical observations focusing on the two dimensions of intentions vs. behavior that
comprise the privacy paradox [37, 38]. (ii) The experimental design uses mixed modalities to achieve
rigor within a controlled lab environment as well as realism, scale and external validity by tracing
behavior out of the lab using a smartphone platform developed for this purpose (see Section 4.2).
(iii) The 4x4x4 factorial design results in 64 data-sharing scenarios (see Fig. 2). They involve the
three data-sharing criteria that model the involved trust (data collectors) and risks (data type and
context), and they are the ones that explain malleable data-sharing behaviors [13, 7, 39]. This
large spectrum comes in contrast to earlier experiments and field tests made within a context and
involving a specific data-sharing scenario such as online social lending [40], crowdfunding [41] and
commerce [16, 13, 42, 43].

2 Results
Three key results are illustrated in this paper: (i) Coordinated data sharing is efficient–it
recovers privacy for people and reduces costs for service providers by accessing less but better quality
of data. (ii) Data collector and context are the most important criteria with which individuals makes
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data-sharing choices. For rewarded choices with privacy loss though, the type of shared data becomes
the most important criterion. (iii) Individuals exhibit five key group-behavior changes from intrinsic
to rewarded data sharing. They are stable, yet reinforcing.

2.1 Coordinated data sharing recovers privacy and lowers costs
The privacy level and data-sharing quality (mismatch) are shown in Fig. 3 for the 64 data-sharing
scenarios and the different experimental conditions. Fig. 4 aggregates these measurements for each
of the four sensors, data collectors and contexts. The shaded areas in Fig. 3a illustrate the expected
privacy level. It is derived by the mean privacy level of the sensor, collector and context that
comprise each data-sharing scenario (see Section 4.3 for exact calculations).

The key observations are summarized as follows: (i) Coordinated data sharing results in signif-
icant privacy recovery (Fig. 3a and 4a) as well as more efficient data sharing (Fig. 3b and 4b) at a
lower cost for service providers (Fig. 5). (ii) Intrinsic data sharing positively correlates to attitudinal
data sharing but has a narrower range (Fig. 4a). (iii) Consecutive rewarded data sharing results in
significant (and similar) privacy loss via, though, different data-sharing choices (Fig. 3a and 4a). (iv)
The privacy loss, rather than the privacy level, under rewarded data sharing is correlated to the per-
ceived privacy sensitivity (Fig. 4a). (v) Individuals improve their privacy by sharing data with lower
privacy sensitivity than when improving rewards, while they keep sharing data to privacy-intrusive
collectors under privacy-intrusive contexts (Fig. 3a).
Coordinated data sharing for efficiency and privacy recovery. Fig. 3b illustrates the mis-
match (absolute error) between a privacy-goal signal (very low and very high privacy preservation)
and the aggregated data-sharing choices made via the AI approach (both standardized). Coor-
dinated data sharing has a lower average mismatch than intrinsic and rewarded data sharing for
both goal signals: 22.8%<30.1%<40.2% for very high and 6.2%<12.1%<15.2% for very low privacy
preservation respectively. With the very high privacy-preservation goal, matching is harder as there
is mainly one data-sharing plan (intrinsic), out of three ones to choose from, containing data-sharing
choices with high privacy preservation. On the contrary, with the very low privacy-preservation goal,
mismatch is minimal by combining data-sharing plans from both the 1st and 2nd rewarded data-
sharing conditions. This trend is also confirmed in the other three privacy-goal signals (see Fig. 11,
Section 8 of SI). For the very low and very high privacy-preservation goal, health (4.7%, 16.5%)
and noise (5.7%, 16.6%) show a low mismatch on average, while government (7.3%, 32.3%) and
social networking (7.1%, 33.8%) show a high one, see Fig. 4b. Via coordinated data sharing, social
networking shows the highest mismatch reduction of 66.6% and 45.5% under the very low and very
high privacy privacy-preservation goals. With an overall average privacy recovery of 77%, these re-
sults demonstrate the unprecedented potential of coordinated data sharing to protect privacy, while
retaining a data-sharing efficiency (see also Fig. 12, Section 9 of SI illustrating different privacy-
recovery valuations). Coordinated data sharing operates close to intrinsic data sharing with a minor
(but significant: t(63) = 9.64, p = 1.00× 10−5 for the very low and t(63) = 7.81, p = 1.00× 10−5 for
the very high privacy-preservation goal) additional privacy sacrifice that is a benefit for data-sharing
efficiency and as a result, the data collective as a whole.
Coordinated data sharing reduces data-collection costs. Fig. 5 shows the incurred data-
collection costs. The monetary cost of the 1st and 2nd rewarded data sharing for data collectors
is 960.18 CHF and 905.14 CHF respectively. This cost is higher than the monetary value of the
data shared intrinsically, which is 628.22 CHF. Strikingly, the cost of coordinated data sharing is on
average 832.56 CHF (σ = 15.93), which is on average 10.7% lower than the rewarded data sharing.
These costs include the monetary value of intrinsic data sharing. If this value is excluded assuming
that this data is shared for free (as happened in the experiment), the cost drops further down to
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Data Sharing: Rewarded ε=15.2%
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(b) Data-sharing mismatch (absolute error ε of standardized signals) between three data-sharing conditions and the
privacy-preservation goal signals of very high and very low. Values are sorted from lowest to highest mismatch
according to coordinated data sharing.

Figure 3: Coordinated data sharing shows higher efficiency than intrinsic and rewarded
data sharing. Privacy and mismatch for the 64 data-sharing scenarios.

626.77 CHF, which is on average 32.9% lower than rewarded data sharing. It is remarkable that
the monetary value of coordinated data sharing is similar to the one of intrinsic, however, it yields
data of higher utility for service providers. As a result, coordinated data sharing is a win-win for all:
lower data collection costs for service providers, higher quality of service via improved data-sharing
efficiency and significant privacy recovery for the participants of the data collective.
Attitudinal-intrinsic data sharing. Privacy preservation under intrinsic data sharing is 21.7%
higher than the perceived privacy (Fig. 4a). While this difference is not significant (t(11) =
−2.07, p = 0.06), the privacy levels between the 12 elements of attitudinal and intrinsic data sharing
are positively correlated (R = 0.63, t(10) = 2.54, p = 0.029), despite the significant drop of 95.3% in
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(b) Data-sharing mismatch between three data-sharing conditions and the privacy-preservation goal signals of very
low (left) and very high (right).

Figure 4: Privacy and data-sharing mismatch level of the different sensors, collectors
and contexts under intrinsic, rewarded and coordinated data sharing. The privacy level
of attitudinal data sharing is also shown. The 12 colored lines are ranked according to the privacy
loss (intrinsic - 1st rewarded data sharing) and mismatch reduction (1st rewarded data sharing -
coordinated).
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nated data sharing is calculated with and without the intrinsic cost. The gray points are random
permutations of the initial conditions in the optimization process.

the dispersion (variance). This result shows that data sharing operates in a narrower decision space
than the perceived privacy. Social networking (0.78, 0.64) and corporation (0.64, 0.62) come with
both high privacy sensitivity and preservation, while education (0.31, 0.5) and accelerometer (0.2,
0.53) show low privacy sensitivity and preservation.
Intrinsic-rewarded data sharing. Under the two rewarded data-sharing conditions, participants
clearly give up privacy by 44% (t(63) = −31.35, p = 1.00× 10−5) and 45.9% (t(63) = −25.49, p =
1.00× 10−5) respectively (Fig. 3a, see also Fig. 9a and 9b in Section 6 of SI). The privacy level of
intrinsic data sharing for the different sensors, collectors and contexts is correlated to the one of
the 1st rewarded data sharing (R = 0.53, t(62) = 4.99, p = 5.00× 10−6) but not to the one of the
2nd rewarded data sharing (R = 0.12, t(62) = 0.94, p = 0.79). Consecutive rewarded data sharing
results in equivalent privacy preservation (t(63) = −1.22, p = 0.23); nevertheless, this effect appears
via different choices made within the data-sharing scenarios (R = 0.033, t(62) = 0.26, p = 0.79).
Attitudinal-rewarded data sharing. Rewarded participants sacrifice privacy by 32.4% (t(11) =
2.72, p = 0.013) and 34% (t(11) = 2.85, p = 0.009) compared to attitudinal data sharing (Fig. 3a).
The privacy level under the two rewarded data-sharing conditions is not correlated to the perceived
privacy sensitivity (attitudinal) of the different sensors, collectors and contexts (R = 0.36, t(10) =
1.22, p = 0.24 and R = −0.39, t(10) = 1.53, p = 0.15 in Fig. 4a). Striking, though, it is the privacy
loss (intrinsic-rewarded data sharing) that correlates to attitudinal data sharing (R = 0.64, t(10) =
2.64, p = 0.025 , R = 0.77, t(10) = 3.82, p = 0.0033).
Which data-sharing scenarios improve privacy and rewards? Under rewards, data-sharing
scenarios are automatically retrieved to fulfill participants’ goal, i.e. data-sharing options with the
highest improvement of privacy or rewards, see Fig. 9. Fig. 3a marks the top-5 scenarios that
result in the highest mean privacy and reward gain (all ranked scenarios are presented in Fig. 8
and Table 10 of SI). The most highly privacy-gaining scenarios involve non-privacy-sensitive sensors
such as accelerometer, which are shared though with privacy-intrusive data collectors and contexts
such as social networking and corporation. In contrast, the most highly reward-gaining scenarios
involve privacy-sensitive sensors such as GPS, which are also shared with the privacy-intrusive data
collectors and context of social networking and corporations. These observations reveal the following:
Individuals improve privacy or rewards by sharing data under privacy-sensitive contexts to privacy-
intrusive collectors. Nonetheless, compared to improving rewards, individuals change to sharing
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data with lower privacy sensitivity when improving their privacy.

2.2 Rewarded individuals better distinguish data than collectors/contexts
Here we study the causal link between the data-sharing criteria/elements (independent variables)
and the privacy/reward gains (dependent variables) in different experimental conditions. Four ex-
planatory models based on a conjoint analysis are outlined in Section 4.5. Fig. 6a illustrates the
regression coefficients of the models, while Fig. 6b shows the relative importance of the data-sharing
criteria and their elements calculated from these coefficients. All models come with R2>0.8 and with
statistically significant values of relative importance (p < 0.05) for the vast majority of data-sharing
elements as shown in Table 13, Section 11 of SI. Fig. 6b also shows the perceived relative importance
derived from the self-reported entry survey questions.

The data collector is the most important criterion (40.73% on average, Fig. 6b) for all models that
predict privacy, and this criterion explains privacy loss (Fig. 6a). Context follows with a 33.91%
of importance explaining privacy loss, while sensor type shows the lowest importance of 25.36%,
explaining the privacy gains. The consistency of these three privacy models reveals the following:
the data collectors to whom individuals share data determine to a high extent (i) the privacy level
under intrinsic or coordinated data sharing and (ii) the privacy loss under rewarded data sharing.
The type of data they share plays a more minor role, though a positive one for privacy preservation.
The models align well with the perception of individuals: 29.4%, 37.85% and 32.75% for sensor type,
collector and context respectively (Fig. 6b). In contrast, for data-sharing choices of individuals with
reward gains, the dominant criterion is the type of sensor data with a 45.4% of relative importance
over the data collector and context with 24.55% and 30.01% respectively. The collectors and contexts
explain loss of rewards, while the type of sensor, and in particular the GPS, explains reward gain.
GPS, as a privacy-sensitive sensor, provides high gain of rewards, and individuals are likely to
be accustomed with apps accessing their GPS data, which is likely to reduce privacy-preservation.
Choices that improve rewards suggest a radically different decision frame than the ones that improve
privacy: a shift from protecting to sharing GPS data without strongly distinguishing anymore the
data collectors and contexts.

Fig. 6b also provides the following observations: The relative importance of the perceived privacy
sensitivity over the 12 data-sharing elements is positively correlated with all models based on privacy:
R = 0.97, t(10) = 12.22, p = 2.46× 10−7 for rewarded data sharing, R = 0.84, t(10) = 4.87, p =
0.00066 for intrinsic−rewarded, R = 0.69, t(10) = 3.025, p = 0.013 for the coordinated data sharing
and R = 0.67, t(10) = 2.89, p = 0.016 for the intrinsic one. All models come with a positive relative
importance for GPS (12.67%), corporation (15.16%) and social networking (20.42%), while negative
one for accelerometer (-11.85%), light (-8.9%), educational institutes (-21.52%), transportation (-
6.13%) and health (-6.63%).

2.3 From intrinsic to rewarded data sharing: five behavior changes
Identifying group behaviors. Table 1 provides an exemplary of all nine possible behavioral tran-
sitions that can happen in data sharing as a result of introducing monetary rewards. A clustering
and stability analysis are performed in the experimental data projected in Fig. 7a (intrinsic vs. 1st

rewarded), which reveal five robust behavioral patterns out of the 9 possible ones (similar groups
are observed for intrinsic vs. 2nd rewarded). See Section 4.6 for more information. Some individuals
are oblivious to rewards. Yet, these are the ones who intrinsically share a significant amount of
data (privacy ignorants and privacy neutrals) or do not share data (privacy preservers). Reward
seekers increase the data-sharing level when rewarded, while reward opportunists intrinsically pre-
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Figure 6: Rewarded individuals sharing data shift the importance from collectors and
contexts to data. Via a conjoint analysis, four multiple linear regression models are compared.
It explains how the different data-sharing criteria and elements influence different key data-sharing
behaviors.

serve privacy but eventually share a significant amount data when rewarded. It is astonishing that
a moderate sacrifice of privacy preservation by rewards is not observed (privacy sacrificers in Ta-
ble 1), meaning that rewards significantly polarize individuals to keep protecting privacy or give up
significant privacy. There are also no cases observed in which rewards motivate change to privacy
protection; however, rewards reinforce privacy protection for privacy preservers.
Groups behavior converges to stable, while boundary ones polarize. The behavioral pat-
tern of privacy sacrificer (Table 1) is found to be a transient one and observed within the reward
opportunists during the first unique responses to the 64 data-sharing scenarios (see Fig. 7b). When
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Figure 7: Five key group behaviors in data sharing and their effects. Revealing the group
behaviors under intrinsic vs. rewarded data sharing, how the group behaviors are formed over the
passage of consecutive data-sharing decisions and the difference of privacy sensitivity between group
pairs for the data-sharing criteria and elements.

though these individuals get more involved in reevaluating their decisions, they converge to a fur-
ther privacy sacrifice of 30.9%. The minimum number of questions answered by all groups is 250.
This incremental privacy decline in reoccurring decision-making is also observed in reward seekers
and privacy ignorants that decrease their privacy level by 55.7% and 64.8% respectively. On the
contrary, privacy preservers show a further increase in their privacy by 8.7% as they reevaluate their
data-sharing decisions. Such a privacy increase of 8.1% is also observed for privacy neutrals.

Strikingly, the two boundary behavioral patterns of privacy preservers and privacy ignorants
show polarization from the very first data-sharing decisions. These individuals reinforce the privacy
preservation and privacy ignorance respectively throughout the choices they make and regardless of
whether these choices are the primary ones (the first 64 questions) or the reassessments (the follow up
reinvoked questions). A similar behavior is documented for data sharing in social media [44, 13, 7],
though this is the first evidence of such behavior in a broader context, involving both privacy and
rewards dilemmas.
How privacy sensitivity of data-sharing criteria explains group behaviors. Fig. 7c shows
all group pairs and the differences between these groups in terms of how privacy sensitive they regard
each data-sharing criterion (attitudinal). Statistically significant observations (p ≤ 0.05) and those
close to the significance threshold are marked in Fig. 7c. These results are derived with a post hoc
Tukey’s range test (α = 0.05) after a one-way Analysis of Variance (ANOVA). The independent
variable is calculated within the groups by the privacy change from intrinsic to rewarded data
sharing. The dependent variables are the privacy sensitivity of the data-sharing criteria and their
elements. Several of these criteria explain the data-sharing groups with a statistical significance (see
Fig. 16, Section 13 in SI): transportation (F (4, 111) = 2.779, p = 0.03), data collector (F (4, 110) =
2.463, p = 0.027), sensor (F (4, 110) = 2.686, p = 0.031), GPS (F (4, 110) = 2.201, p = 0.033), noise
(F (4, 110) = 3.573, p = 0.056).

In Fig. 7c, the data collector (p = 0.017) and the GPS sensor (p = 0.052) explain the privacy-
sensitivity difference between reward opportunists and privacy ignorants: rewarded individuals of
these groups share a significant level of data, while reward opportunists preserve privacy without
rewards. Compared to privacy ignorants, reward opportunists find data collector and GPS more
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privacy intrusive by 24.2% and 20.4%. Similarly, the context of health (p = 0.042) and the GPS
sensor (p = 0.033) explain the divergence between privacy neutrals and privacy ignorants. Privacy
neutrals find these two data-sharing criteria 26.6% and 20.9% more privacy intrusive than privacy
ignorants. Privacy neutrals also find sensors (p = 0.033) more privacy intrusive than reward seekers
by 18% which explains the higher data sharing of rewards seekers under rewards. Finally, the data-
sharing criterion of educational institute determines when individuals share a very high or very low
level of data with or without rewards: privacy preservers find the context of education (p = 0.058)
25.9% more privacy intrusive than privacy ignorants.

3 Discussion
The findings reveal that a significant privacy recovery is attainable within the modus operandi
of a data collective. This is a radical shift from mainstream thought of privacy as a personal
value to privacy as a collective value [45], a public good shared within a community of citizens
generating data. Coordinated data sharing supported by a trustworthy decentralized AI automates
and scales up collective arrangements for sharing under the doctrine ‘as little as possible as much as
necessary’. Such optimized arrangements would be otherwise too complex and expensive to achieve
in a transparent way with existing top-down privacy policies and regulations or even with automated
data-access committees [46].

Findings also reveal that data collectives create tangible benefits for online service providers that
collect or access data shared in a coordinated way: data collection costs drop down dramatically and
data are used more purposefully to deliver the required quality of service. This can create further
remarkable cost reductions such as reduced data storage, security, energy and carbon footprint costs
as well as costs for solving legal disputes that are more likely to incur when dealing with excessive
personal data.

Within rising information asymmetries and monopolies of knowledge in existing data markets
and big tech, the capability of data collectives to coordinate data sharing at large-scale has been
so far a gap [47, 48]. This is underlined in promising solutions from political and economic theory
such as data-owning democracy [49], digital socialism [47] and peer-to-peer digital commons [50].
Establishing data collectives at a community or municipality level can create alternative forms of
data ownership and control; they can empower citizens participation based on an agenda of using
digital assets for priorities such as social welfare and environmental sustainability [48, 51]. These
blueprints can be the basis of alternative data-market designs that encourage business models based
on social innovation without over-relying on excessive free personal data. Data collectives can further
benefit from scale, for instance, increasing individuals who coordinate their data-sharing decisions
or increasing individuals’ contributions by generating more alternative data-sharing options. The
AI system based on collective learning has a higher degree of freedom to calculate data-sharing
choices that match the required data and recover more privacy in larger populations [24]. It is also
decentralized to make coordination more resilient to computational bottlenecks.

Science can also benefit from data collectives. They can scale up open data and citizen science
initiatives, while improving the transparency and reproducibility of research.

Choices under intrinsic and rewarded data sharing prioritize different criteria. Individuals better
distinguish data collectors and contexts than the type of data they share. In contrast, rewarded
individuals that give up privacy better distinguish the type of data they share, and in particular the
GPS. Thus, rewards diminish the importance of who collects data and for what purpose. In this
case, data collectors may have no competitive advantage against each other but instead excessive
and irrelevant data that increase their costs and risks.
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The perceived privacy sensitivity of the data-sharing criteria explains different key data-sharing
behaviors (groups), for instance, individuals who do not preserve privacy vs. individuals who sac-
rifice privacy under rewards. Raising awareness about the privacy sensitivity of data collectors can
influence data-sharing decisions. This has implications for how privacy policies and data consents
are designed to be more transparent and user-friendly. Data-sharing choices that preserve and give
up significant privacy tend to polarize, thus highlighting the value of privacy for individuals who
have it rather than for the ones who do not [13]. Coordinated data sharing breaks this vicious cycle
by redistributing the privacy cost within the individuals for the benefit of all. This demonstrates
opportunities for digitally networked societies without borders to reconcile different cultural norms
on privacy.

Future work can unleash further opportunities to reclaim privacy in the digital age: Spatio-
temporal coordinated data sharing can automate and scale up the “right to be forgotten", which
improves both privacy control and the willingness to share data, e.g. 10%-18% [11]. The feasibility
of collective learning using optimization scenarios in time and space are earlier demonstrated for
Smart City applications [24]. Nevertheless, defining and conveying to individuals the context of data
use is not always straightforward and further work is required in this area, for instance, semantics
and ontologies [46]. Moreover, beyond purposeful data sharing, speculative data analysis out of a
specific context can also encourage innovation and creativity. In such scenarios, data collectors may
have a more significant role for trust in data-sharing decisions. The acceptance of coordinated data-
sharing recommendations requires a follow up study, in particular, the incentives and the interface
design of the AI system for the broader population. Notwithstanding, earlier results demonstrate
significant coordination capacity even when large portions of the population are not flexible [52].
The explainability of coordinated data sharing based on decentralized AI is particularly challenging
and is expected to further shield the trust on data collectives.

4 Methods
We outline here the experimental design and the developed technical infrastructure. We also illus-
trate the methods with which we analyzed the experimental data and the AI-based decision-support
system with which coordinated data sharing is performed.

4.1 Living-lab experimental design
A novel design for a ‘living-lab’ experiment is introduced. It defines a mixed-mode experiment
that seamlessly integrates in participants’ everyday life, while the overall experimental process is
orchestrated via the controlled environment and experimental protocols of the Decision Science
Laboratory (DeSciL) of ETH Zurich [53]. The proposed experiment has received ethical approval
by DeSciL and the Ethics Commission at ETH Zurich (#EK 2016-N-40). To improve the realism of
the experiment and comply to the non-deceiving policy of DeSciL, letters of support were collected
from data collectors to confirm their interest in accessing the collected sensor data of participants.
The study consist of three phases: (i) entry, (ii) core and (iii) exit. Fig. 8 provides an outline
of the overall experimental process and the developed data-collection infrastructure (details are
documented in Section 3 of SI).
Recruitment approach and sampling biases. The living-lab experimentation involves the re-
cruitment of 123 participants during the entry phase, out of which 116 completed the exit phase
and 89 participated in all phases. Aggregated privacy-reward records for all experimental conditions
is found for 84 participants. Responses to the data-sharing scenarios for all experimental condi-
tions are found for 73 participants. In the context of this study, a higher number of participants
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Figure 8: A data-collection infrastructure used for the design of a novel ‘living lab’
experiment of high realism and rigor. The experiment consists of three phases in and out of
the lab. Data are collected via smartphones and are made accessible to data collectors according to
the privileges given by participants.

is particularly challenging and probably unrealistic as it requires significantly more resources for
compensation/infrastructure, sacrifice of rigor, and much looser control of the experimental process.
Instead, priority is given to a satisfactory compensation per participant for active participation in
all experimental phases (see Section 3.5 in SI) and by incentivizing appropriately a large number of
data-sharing choices: 27403 in total. Moreover, the development of a data-collection platform, in-
cluding the data-access web portal and the mixed-mode experimental process, preserves an eminent
realism, yet in well-controlled laboratory conditions that result at the end in a novel high-quality
dataset to study causal inference.

Participants were recruited from the DeSciL pool [54], mainly consisting of students of ETH
Zurich and University of Zurich (see the invitation in Section 2.2 of SI). This pool is not represen-
tative of the population and is subject to sampling biases. However, smartphone users, who use a
broad range of apps that require sharing of sensor data are mainly young people [55, 56, 57], and
therefore the students’ profile fits well with the nature of the conducted experiment. Participants
with technological literacy are also more likely to be familiar with data-sharing dilemmas involving
a privacy cost to gain access to smartphone app services. Studying such a sample of participants
can make results more compelling as shown in earlier experiments conducted on such recruitment
basis [58]. Only Android smartphone users are recruited, who are a large portion of the popula-
tion, for instance, 39.8% in Switzerland, 68.6% in Europe and 72% worldwide in 2016 according
to StatCounter. Moreover, several smartphone apps with data-sharing decisions are made for both
Android and iOS. Therefore there is no substantial evidence to suggest different decision patterns
among the market share in the population as also supported in earlier work [58]. Recruitment is
performed in 8 sessions on a weekly basis. To eliminate any further temporal bias, each of the three
phases in Fig. 8 took place on the same day of the week. Table 2 in SI provides an overview of the
experimental sessions.
Entry phase. It takes place at DeSciL and it involves the following: (i) Collection of basic demo-
graphics about participants and information about their privacy profile using the survey questions
of Table 4 in SI. (ii) Use of the privacy-intrusion level assigned to each data-sharing criterion and its
elements (Questions B.9-B.12) to calibrate the calculation of the monetary rewards for the core phase
according to the model illustrated in Section 1 of the SI. (iii) Collection of the intrinsic data-sharing
decisions by letting participants choose once the data-sharing level for each of the 64 data-sharing
scenarios (see Fig. 3b in SI). The following question implements the data-sharing scenarios:
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Factorial Question. Please choose the amount of <sensor type> sensor data shared with <data
collector> to be used in the context of <context>.

There are in total five possible data-sharing levels to choose from (see Fig. 3b in SI).
Core phase. It takes place out of the lab and lasts for two days (48 hours), starting right after the
completion of the entry phase. During the 24 hours of each day, participants are voluntarily involved
in an (unlimited) sequence of dilemmas of either improving their privacy or rewards by sharing less
or more data respectively in a data-sharing scenario. Fig. 9 illustrates the two app screens for
the privacy-rewards dilemma and the data-sharing scenario that follows. First, participants decide
what to improve based on their privacy-rewards balance they currently have (Fig. 9a). Next, a
data-sharing scenario is automatically retrieved with the latest choice made (Fig. 9b), marking the
options that fulfill their goal (the improvement box, see Arrow 6). The retrieved scenario is the
one that maximizes the improvement of the chosen goal, i.e. privacy or rewards. For each option,
the app informs participants about the rewards and privacy they gain or lose (Arrows 3 and 4
respectively). After a choice, the participant moves back to the main screen of Fig. 9a with an
updated privacy-rewards balance.

(a) Privacy vs. rewards dilemma

1 2

4

3
5

6

(b) Data-sharing scenario choice

Figure 9: The key experimental functionality of the smartphone app. Arrows: (1) Accu-
mulated rewards. (2) Privacy level. (3) Gain/loss of rewards for a particular option. (4) Gain/loose
of privacy for a certain option. (5) Data-sharing options. (6) Options in the improvement box.

The first unique 64 data-sharing scenarios are the ones that participants have decided about
during the entry phase. The difference in this core phase is that data sharing is rewarded based on
two factors defined in the data-sharing model (see Section 1 of SI): (i) the data-sharing level (the
higher, the more rewards) and (ii) how privacy-intrusive the data-sharing scenario is according to
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each participant. More rewards are allocated to data-sharing scenarios involving criteria regarded
highly privacy-intrusive by a participant. The latter personalization is derived from the responses of
the entry phase (Questions B.9-B.12 in Table 4 of SI) without explicitly making participants aware
of this.

Within the 24 hours, participants can change their goal based on their privacy-reward balance.
They continue responding to further retrieved data-sharing scenarios that can satisfy their goal, i.e.
improve privacy or rewards, see Fig. 9a. This allows studying how data-sharing decisions evolve.
Each decision in a data-sharing scenario overwrites the previous one for the calculation of the privacy-
reward balance. At the end of the 24 hours, the process completes by locking the decisions of the
64 scenarios and sharing the data to the data-access web portal. This process runs for two days to
validate the results, confirming similar data-sharing behavior at both days (see Fig. 3a as well as
Fig. 9a and 9b in SI).
Exit phase. The participants of each experimental session return to DeSciL on the 4th day. They
answer a survey questionnaire, participate in an interview and receive their calculated compensation.
The survey consists of questions that cover the following aspects (see Table 6 to 9 in Si): (i)
smartphone use, (ii) user interface and functionality of the app, (iii) rewards and privacy, (iv)
experimental process. The data collected during this phase have a supportive role serving the
validation and interpretation of the results produced during the entry and core phase. See Section 3.4
of SI for further details.
Compensation and monetary incentives. Participants are compensated for their engagement
in the experiment as well as for the sensor data they share. The engagement covers (i) showing up in
the lab (2 ·10 = 20 CHF), (ii) completing the lab activities (15+5 = 20 CHF) and (iii) using the app
in terms of answering at least once all 64 data-sharing scenarios (2 · 2.5 = 5 CHF). The rewards for
the app use is distributed with a geomentric progression over the data-sharing scenarios to eliminate
dropout effects (see Section 3.5 of SI). Those who successfully complete all experimental phases
receive the total fixed compensation of 45 CHF and an additional maximum reward of 2 · 15 = 30
CHF based on the amount of shared data. Fig. 8 shows how the total maximum amount of 75 CHF
is allocated over the experimental process. Section 3.5 of Si further motivates the allocation of these
compensations.

4.2 Technical infrastructure
Fig. 8 outlines the technical infrastructure developed to serve the designed experimental process. Two
types of data are collected by the smartphone app: (i) the sensor data that participants explicitly
choose to share and (ii) all data from participants’ choices and survey answers used for the analysis.
These data are stored on a remote server and locally on the smartphone for redundancy so that they
can be restored during the exit phase by moderators in case of software or communication failures.

The developed infrastructure consists of the following interactive systems: (i) the local and
(ii) remote data-management system, (iii) the smartphone app and (iv) the data-access web portal.
The two data-management systems synchronize and secure the shared sensor data as well as the
experimental data. The smartphone app is developed to run on Android devices. The data-access
web portal stores the shared data and provides authorized access to the registered participants of the
experiment as well as the data collectors involved in the data-sharing scenarios. Making available
this system improves the realism of the experiment by realizing the actual data-sharing decisions,
while allowing the experimental design to comply with the non-deceiving policy of DeSciL. See
Section 4 of SI for further details.
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4.3 Privacy calculations for sensors, collectors and contexts
The privacy measurements in Fig. 4a are made as follows: In the case of the attitudinal data-
sharing condition, the mean privacy level is calculated by normalizing (in [0, 1] over all participants)
the privacy sensitivity reported in the Questions B.10-B.12 during the entry phase. In the intrinsic,
rewarded and coordinated data-sharing conditions, the privacy level of a certain sensor, data collector
or context is the normalized privacy mean across all participants for 16/64 data-sharing scenarios
that contain this respectively (see Fig. 3a). In the coordinated data-sharing conditions, this is
calculated using the mean privacy level of the data-sharing scenarios selected over all 10 repetitions
of the coordination with a random positioning of the agents (see Section 4.4 for more information).

The expected privacy level of a data-sharing scenario (see shaded areas in Fig. 3a) is calculated by
the mean privacy level of the sensor, collector and context that comprise the data-sharing scenario.
The expected privacy level of a certain sensor, data collector, or context is the mean expected privacy
level over 16/64 data-sharing scenarios containing this. The relative difference between the actual
privacy level and the expected one defines the privacy reinforcement. Detailed measurements are
illustrated in Fig. 13, Section 10 of SI.

4.4 Coordinated data-sharing via decentralized AI
Coordinated data sharing is modeled as a decentralized multi-agent combinatorial optimization
problem. It is designed to recover excessive privacy loss by rewarded data sharing. A decision-
support system implements the optimization that achieves the coordination. The discrete choice
model and the coordination method are outlined below.
Data-sharing plans and elicitation of privacy sensitivity. Each participant comes with three
data-sharing plans extracted from the living-lab experiment as follows: each plan is a sequence of
64 real values that represent the data-sharing choices made at each scenario and each experimental
condition: intrinsic, 1st rewarded and 2nd rewarded. Each plan has a privacy cost represented
by a real value. It is calculated by the mean normalized level (in [0, 1]) of shared data over the
data-sharing scenarios. Alternative privacy valuation schemes are assessed in Section 9 of SI.
Steering data sharing using privacy-preservation goal signals. A goal signal represents a
data-collection scenario with the minimum required data to enable a data-driven service or appli-
cation [30, 31, 32]. Five privacy-preservation goal signals for data sharing are generated using the
intrinsic data-sharing choices of participants. Each goal signal is a sequence of 64 values corre-
sponding to the data-sharing scenarios. For each data-sharing option out of the five possible ones, a
goal signal is calculated with the 64 values representing the probability of participants choosing this
data-sharing option without rewards. Similarly with the data-sharing options, the five goal signals
are referred to within the range of very low to very high privacy preservation. Fig. 10, Section 7 in
SI illustrates the five goal signals.
Coordinated data sharing. The goal of the data collective is to choose and aggregate (sum
up element-wise) the data-sharing plans of all individuals such that the resulting signal matches a
given goal signal for privacy preservation. This matching is measured here with the residual sum
of squares between these two signals (standardized). As this goal cannot be satisfied by letting
individual participants choosing independently the plan with the best matching (minimizing a non-
linear cost function), coordination between participants’ choices is required. This discrete-choice
coordination problem is combinatorial NP-hard and requires approximating solutions [24]. The
coordination capability can be generalized to a multi-objective combinatorial optimization problem
in which the data collective minimizes the following cost function:

(1− α− β) · privacy inefficiency+ α · privacy unfairness+ β · privacy cost, (1)
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where privacy inefficiency is the residual sum of squares between the aggregated data-sharing plans
and the goal signal, privacy cost is mean cost of the selected plans and the privacy unfairness is
the dispersion (variance) of privacy cost over individuals. The parameters α and β, for α + β = 1
and α, β ∈ [0, 1], are self-determined by each individual and model a behavioral continuum between
selfish vs. altruistic behavior in terms of data sharing. A selfish individual that minimizes privacy
without coordinating its data sharing with other individuals is determined by β = 1, α = 0. An
individual that minimizes the collective privacy inefficiency without counting its personal privacy
cost is an altruistic one by β = 0, α = 0. And these altruistic individuals can balance for privacy
unfairness by increasing the α parameter.
A decentralized computational approach for coordination. The collective learning method
of I-EPOS is used to cope with the computational and communication complexity of the coordinated
data-sharing problem [24]. This algorithm is used as a decision-support system that automates and
scales up the coordination, which would otherwise be too complex and infeasible for humans to
perform without digital assistance. This method is particularly fitting in this privacy context: (i)
The algorithm itself is privacy-preserving by design as it exclusively relies on exchanging aggregated
(and not individual) information. The use of differential privacy and homomorphic encryption can
also enhance the overall security of information aggregation. (ii) The algorithm is highly cost-
effective with a low computational and communication complexity compared to other multi-agent
approaches for combinatorial optimization problems [24]. The data-sharing choices calculated by the
algorithm can rapidly match the goal signal with a low communication exchange between the agents.
(iii) The algorithm is open-source, decentralized and can scale up without relying on a trusted third
party, which makes it particularly applicable for bottom-up data collectives. (iv) The algorithm can
operate in different faulty environments and application scenarios [59].
Collective learning parameterization. Agents are self-organized in a binary balanced tree within
which they are positioned randomly. Coordination repeats 10 times, each with a different random
positioning of the agents. For each random positioning, collective learning runs for 50 learning
iterations. Each iteration proceeds from leaves to root and back to leaves. It results in the selection
of data-sharing plans that minimize at an aggregate level the cost function in Equation 1. More
information about the algorithm can be found in earlier work [24].

4.5 Causal inference with conjoint analysis
The complete factorial design of 3 data-sharing criteria each with 4 elements results in 64 scenarios
encoded by a sequence of 12 − 3 = 9 dummy variables. These represent the membership of a
certain sensor, collector and context in a data-sharing scenario. Multiple linear regression models
are constructed using as independent variables the nine dummy variables (4 − 1 = 3 variables per
data-sharing element are used to resolve the linear dependency problem in multiple regression). The
dependent variables that distinguish the regression models include the following (Fig. 6): privacy
(intrinsic, intrinsic−2nd rewarded, coordinated with very low privacy-preservation goal) and gained
rewards (1st and 2nd rewarded data sharing with those individuals who intend and do improve
rewards as in Fig. 9). These privacy and reward values across the 64 data-sharing scenarios of the
full factorial design are used for a rating-based conjoint analysis. Other regression models with lower
statistical power are assessed and further illustrated in Fig. 14, Table 13, Section 11 of SI.

The regression models result in the 12 coefficients for each data-sharing element as shown in
Fig. 6a. Together with a constant (Table 13 in Si), they predict the depend variable. Using the
coefficients, the partworth utilities are estimated that calculate the relative importance of each
data-sharing criterion and element (Equations 11 and 12 in SI). For each data-sharing element, the
relative importance is calculated across the elements of the criterion it belongs (Equation 12) or
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across all elements (Equation 13). The latter is shown in Fig. 15 of SI. The conjoint analysis models
are compared to the mean relative perceived privacy sensitivity as declared by participants in the
Questions B.9-B.12 in Table 4 of SI.

4.6 Extraction and validation of group behavior
How groups are extracted. To extract the data-sharing group behaviors, the participants’ pri-
vacy level under intrinsic and 1st/2nd rewarded data sharing are clustered using three clustering
techniques: of R (i) k-means [60] (kmeans), (ii) hierarchical clustering [61, 62] (hclust) and (iii)
partitioning around medoids [63] (pamkCBI). A subset of 110 participants were clustered that made
both intrinsic and rewarded data-sharing decisions. An optimum number of five clusters is confirmed
in all three methods that correspond to the data-sharing groups marked in Fig. 7a. An exemplary
of observed and unobserved group behaviors is outlined in Table 1.

Table 1: Exemplary of possible group behaviors with and without rewards in data shar-
ing. A low, moderate and high level of data sharing is assumed for illustration purposes. 3: denotes
the observed group behaviors. 7: denotes the unobserved group behaviors.

Without Rewards With Rewards

Data Sharing: Low Moderate High Low Moderate High

Privacy ignorants 3 3
Privacy neutrals 3 3
Privacy preservers 3 3
Rewards seekers 3 3
Rewards opportunists 3 3

Privacy sacrificers 7 7
Reward opposers (sharer) 7 7
Reward opposers (neutral) 7 7
Reward sacrificer (sharer) 7 7

How groups are validated. In the case of k-means and hierarchical clustering, the optimum
number of five clusters is derived by performing a bootstrap evaluation (clusterboot of R) of the
clusters [64]. It assesses both the stability of the clusters and the stability of different clustering
algorithms. The pamkCBI algorithm performs partitioning around medoids. The number of clusters
is estimated by the optimum average silhouette width [65, 66]. However, a bootstrap evaluation is
also performed for pamkCBI for a complete comparison of the three algorithms. An outline of the
clusters stability (mean Jaccard similarity) and the number of dissolved clusters for 100 bootstrap
iterations is given in Table 14 of SI. Visual inspections show that all three algorithms find the
same clusters, while k-means achieves a mean Jaccard similarity (bootmean) higher than 0.75 for all
clusters, which indicates stable clusters. As such, the groups of k-means are analyzed in this paper
(Fig. 7). Note also that the population split over the data-sharing groups matches well to Westin’s
general population privacy indexes, see further Section 12 of SI.

Data Availability
The collected data of the living-lab experiment are made available at: https://doi.org/10.6084/
m9.figshare.21750158. The generated plans are made part of the following planning portfolio:
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https://doi.org/10.6084/m9.figshare.7806548.v5.

Code Availability
The source code of the AI system is under active development at https://github.com/epournaras/
epos. Source code used and developed for this paper is made available at https://doi.org/10.
5281/zenodo.7457575.
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1 General Data-Sharing Model
This section provides the mathematical formulation of human data-sharing choices under personal-
ized (monetary) incentives. Table 1 provides an overview of the mathematical notations.

Table 1: An overview of the mathematical symbols.
Symbol Interpretation
k Number of data-sharing criteria
u A data-sharing criterion
lu Number of elements of a criterion u
m Number of data-sharing scenarios
i An individual
j A data-sharing scenario index
z Number of data-sharing levels
si,j The selected data-sharing level of individual i for a data-sharing scenario j
Dj A data-sharing scenario
fi(Dj) A data-sharing decision function of individual i in a data-sharing scenario Dj

dj,u An element of criterion u in a data-sharing scenario j
n Number of individuals
wi,u The weight of criterion u by an individual i
o The index of an element of a data-sharing criterion
wi,o,u The weight of an element o of a criterion u by an individual i
Wi,j The weight of a data-sharing scenario j by an individual i
B Maximum (monetary) budget
Bp Rewards for participation
Bs Rewards for data sharing
r̂i,j The maximum rewards of individual i for a data-sharing scenario j
Wi The total weight of all data-sharing scenarios by an individual i
ri,j The actual rewards of an individual i for a data-sharing scenario j
pi The privacy level of an individual i derived from the data-sharing choices
λu,o The coefficient of a data-sharing element o in the criterion u
Du,o The dummy variable for the absence or presence of the data-sharing element o in the criterion u
ε The error of the regression model
Pu The partworth utility (relative importance) of criterion u
P̂u,o The partworth utility (relative importance) of element o in criterion u among all criteria
Pu,o The partworth utility (relative importance) of element o within criterion u
Pj The mean privacy level of a data-sharing scenario j
ε The mismatch (absolute error) of data sharing from a privacy-preservation goal signal
Rj The mean rewards level of a data-sharing scenario j
ri The rewards of individual i gained over the data-sharing scenarios
r̃i The hypothetical rewards of an individual i gained over the data-sharing scenarios under intrinsic data sharing
Ci(ri) The privacy cost of a data-sharing plan generated by individual i as a function of ri
α, β The weights of privacy unfairness and privacy cost respectively in the optimization cost function
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1.1 Data-sharing criteria
Let k factors, referred to as criteria, govern the level of data sharing that an individual, i.e. a citizen,
chooses. This ranges from sharing no data to sharing all locally available data in an individual’s
device such as a smartphone. Each criterion u ∈ {1, ..., k} has a number of possible elements lu.
For instance, the type of sensor data is a criterion with the following elements (see Figure 2 in the
main paper): GPS location, light sensor, etc. The former element may be regarded more privacy
intrusive than the latter one. The total number:

m =
k∏

u=1

lu, (1)

of combinations between the lu elements of the k criteria define the scenarios of data sharing, which
are the ones studied in this paper. For each data-sharing scenario j ∈ {1, ...,m}, individuals have a
number of z discrete data-sharing options, where the first option corresponds to sharing all collected
data, whereas the zth option corresponds to sharing no data. Each individual i selects a data-
sharing level si,j ∈ {1, ..., z} for scenario j. For simplicity, assume that the actual level of data
sharing decreases linearly from 1 to z by, for instance, averaging, obfuscating or resampling the data
to share (e.g. with a period proportional to si,j). The data-sharing level si,j is a result of a function:

si,j = fi(Dj), (2)

where Dj =(dj,u)ku=1 represents the data-sharing scenario j as the sequence of elements dj,u ∈
{1, ..., lu} over all k criteria. For the sake of simplicity in the model illustration, the number of
criteria k and the number of elements lu for each criterion u are assumed finite and fixed for all n
individuals.

1.2 A weighting scheme for personalized privacy valuation
Let the weight wi,u ∈ [0, 1] denote how privacy-sensitive a criterion u is for an individual i relative
to the rest of the criteria, such that

∑k
u=1 wi,u = 1. Similarly, the weight wi,o,u ∈ [0, 1] denotes how

privacy-sensitive an individual i finds the element o ∈ {1, ..., lu} of criterion u relative to the rest of
the elements, such that

∑lu
o=1 wi,o,u = 1.

The weight Wi,j of a data-sharing scenario j is determined by each criterion weight wi,u and
each element weight wi,o,u it consists of as follows:

Wi,j =
k∑

u=1

wi,u · wi,o,u, (3)

where o = dj,u is the element of criterion u in the data-sharing scenario j.
The weighting scheme is used to model the heterogeneity in the availability of data that stems

from the individuals’ privacy perception, i.e. it is expected that privacy-sensitive data are more
scarce and as a result they are also expected to have higher value in data sharing.

1.3 Calculating rewards and privacy
The calculation of rewards and privacy relies on the weighting scheme for personalized privacy
valuation (Section 1.2). Assume there is a maximum (monetary) budget B to incentivize data
sharing that is split as follows:
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B = Bp +Bs, (4)

where Bp rewards participation, meaning the cognitive effort required for individuals to make choices
for all data-sharing scenarios and Bs rewards the actual data sharing respectively. Moreover, assume
that the weights of each criterion/element represent the actual intrinsic privacy concerns of individ-
uals. The maximum rewards r̂i,j of an individual i for each data-sharing scenario j are allocated
according to self-determined privacy-intrusion level of the data-sharing scenario as follows:

r̂i,j =
Wi,j

Wi ·Bs
, (5)

where the weight Wi sums up the weights of all scenarios as follows:

Wi =

m∑

j=1

Wi,j . (6)

The actual received rewards of an individual i with a data-sharing level si,j under a data-sharing
scenario j are calculated as follows:

ri,j =
z − si,j
z − 1

· r̂i,j . (7)

The privacy of an individual i over all selections made in the m data-sharing scenarios is calculated
as follows:

pi =
1

m

m∑

j=1

si,j − 1

z − 1
. (8)

2 Recruitment Process
The split of the recruitment process into multiple sessions as well as the invitation for the recruitment
are illustrated in this section.

2.1 Recruitment sessions
Splitting the recruitment of participants and the experiment into multiple sessions serves the follow-
ing: (i) Guaranteeing enough time to recruit participants from the pool. (ii) Having a manageable
number of participants to moderate during the experimental process. (iii) Scale up the number of
participants incrementally so that potential failures do not influence the overall experiment. The
entry phase takes place on Mondays, the core phase during Mondays-Wednesdays and the exit phase
on Thursdays.

Table 2: Recruitment during the 8 experimental sessions performed.
Session: 1 2 3 4 5 6 7 8

Entry Phase 3.10.2016 17.10.2016 31.10.2016 7.11.2016 14.11.2016 21.11.2016 28.11.2016 5.12.2016
Core Phase 3-5.10.2016 17-20.10.2016 31.10-2.11.2016 7-9.11.2016 14-16.11.2016 21-23.11.2016 28-30.11.2016 5-7.12.2016
Exit Phase 6.10.2016 21.10.2016 3.11.2016 10.11.2016 17.11.2016 24.11.2016 1.12.2016 8.12.2016
Num. of Participants 15 13 11 16 15 13 19 21
Compensations (CHF) 666.0 813.0 746.0 840.0 943.0 805.0 1259.0 1283.0
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A 93.6% of the participants did not know about the experiment before participating (Question
D.28 in Table 9).

2.2 E-mail invitation for recruitment
The invitation sent to the DeSciL pool of participants for the recruitment is presented below:

Dear <firstname> <lastname>,

We would like to invite you to an upcoming experiment
’<experiment name>’. The experiment will be carried out
in English, so you should be fluent in English in order
to register for this study.

The experiment requires your participation at the
ETH Decision Science Laboratory at TWO different days and
the use of your mobile phone (Android only) at other two
days to answer some questions.

Your participation in the experiment will be maximally
compensated as follows:

Session 1: CHF 25.-
Core phase on mobile phone: Up to CHF 35.-
Session 2: CHF 15.-
Total: Up to CHF 75.-

You MUST attend both lab sessions in order to receive
your payment. Furthermore, the following criteria are
a requirement:

1) have and use an Android mobile phone, version 4.4
and above
2) have mobile Internet connection
3) Keep your phone switched on and adequately charged
throughout the experiment
4) officially register for the study
5) arrive on time for the experiment at both days
6) install and use a mobile application to answer some
question at two days
7) fulfill all experimental criteria including specified
language proficiency
8) provide photo identification.

The sessions are scheduled as follows:
<session list>

If you want to participate, you can register by clicking on the following link:
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<link>

(If you cannot click on the link, copy it to the clipboard by selecting it,
right click and choosing "Copy",
and then paste it into the address line in your browser
by right clicking there and choosing "Paste".)

Kind regards
ETH Decision Science Laboratory (DeSciL)
http://www.descil.ethz.ch/contact/

3 Experimental Design
The preparatory, entry, core and exit phase of the conducted experiment are outlined here in more
detail. The compensation and monetary incentives introduced to engage participants are also illus-
trated.

3.1 Preparatory phase
The preparatory phase has a supportive role in the overall experiment as participants are neither
compensated nor selected rigorously. Participants of the preparatory phase are selected from the
network of employees at ETH Zurich (convenience sampling). The findings of the preparatory phase
are not conclusive and mainly serve the design of the following phases. Nevertheless, this phase was
scaled up to approximately 200 participants within 3 months, starting on 19.05.2016.

The preparatory phase consists of a web survey implemented in Qualtrics [1] with the questions
outlined in Table 3. The goal of the preparatory phase is to provide some first insights about the
perception of privacy from the perspective of the three studied aspects: sensor type, data collector
and context. Questions A.9-A.14 are designed for this purpose. Questions A.6-A.8 provide informa-
tion about the smartphone usage profiles, whereas, Question A.15 scrutinizes the type of incentives
that motivate participants to share mobile sensor data. Questions A.1-A.5 collect demographic
information.

3.2 Entry phase
The participants of each experimental session are verified by the DeSciL staff members by presenting
a personal identification document, i.e. a passport or student card, nevertheless, the actual identity
of the participants remains anonymous to the researchers using the lab. Participants are not allowed
to interact with each other during the experiment and any questions need to be addressed in private
directly to the experiment moderators by moving to a next room. In this way, biases about how
each participant perceives and understands the experimental process are eliminated. This process
is communicated to the participants before the beginning of the experiment. Next, participants are
seated in a room with instructions about the experiment (Figure 1) and the information consent
(Figure 2) placed in front of them.

The Android app was made available in Google Play online store for the participants to download,
see Figure 3a. The app generates locally in the background a unique ID used as identifier of the
participants in the experiment as well as in the data collected in the database. This ID can be
viewed in the app by participants. The first screens of the app present the survey questions B.1-B.8
of Table 4.
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Table 3: Survey questions for the preparatory phase.
ID Question Type Options

A.1 What is your gender? multiple choice,
one selection

female, male

A.2 Which year were you born? multiple choice,
one selection

81 [1920,2000]

A.3 In which country have you lived most of your life? multiple choice,
one selection

all countries

A.4 What is the highest level of education you have completed? multiple choice,
one selection

less than high school, high school, some
college, bachelors degree, masters de-
gree, PhD degree

A.5 Which of the following categories best describes your employment status? multiple choice,
multiple selections

employed full time, employed part
time, unemployed (looking for work),
unemployed (not looking for work), re-
tired, student, disabled

A.6 Which types of apps do you usually have on your smartphone? multiple choice,
multiple selections

education, entertainment, finance,
game, health & fitness, medical, music
& audio, news, productivity, shopping,
social networking, transportation,
travel, utility, weather

A.7 How many times do you check your mobile phone during the day (e.g. check notifica-
tions/time, open apps, etc.)?

multiple choice,
one selection

1-35, 36-70, 71-100, 101-135, 135+

A.8 How concerned are you about the privacy of your mobile sensor data? ratio scale 5 [Not at all concerned,extremely con-
cerned]

A.9 Which level of privacy intrusion would you assign to the following mobile sensors? group of questions 12 questions
A.9.1 Accelerometer (it measures the changes of the velocity of the smartphone) ratio scale 5 [very low,very high]
A.9.2 Gyroscope (it measures the rotation/twist of the smartphone) ratio scale 5 [very low,very high]
A.9.3 GPS (it measures the geographical location of the smartphone) ratio scale 5 [very low,very high]
A.9.4 Proximity Sensor (it measures the physical distance of the smartphone from your

body)
ratio scale 5 [very low,very high]

A.9.5 Ambient Light Sensor (it measures the ambient light level) ratio scale 5 [very low,very high]
A.9.6 Battery Sensor (it measures the battery level) ratio scale 5 [very low,very high]
A.9.7 Microphone (it measures several sound features. e.g. level of sound frequencies) ratio scale 5 [very low,very high]
A.9.8 Camera ratio scale 5 [very low,very high]
A.9.9 Thermometer (it measures the temperature of the device) ratio scale 5 [very low,very high]
A.9.10 Air Humidity Sensor (it measures the relative humidity in a range 0-100%) ratio scale 5 [very low,very high]
A.9.11 Barometer (it measures the atmospheric pressure) ratio scale 5 [very low,very high]
A.9.12 Bluetooth (it measures the proximity of the device with other devices) ratio scale 5 [very low,very high]

A.10 How important for your privacy is the type of sensor from which you share data? ratio scale 5 [not at all important,extremely im-
portant]

A.11 Which level of privacy intrusion would you assign to the following stakeholders if you had
to share your mobile sensor data with them?

group of questions 12 questions

A.11.1 Corporations/companies ratio scale 5 [very low,very high]
A.11.2 Non-profitable/non-governmental organizations ratio scale 5 [very low,very high]
A.11.3 Educational institutes (Public) ratio scale 5 [very low,very high]
A.11.4 Governments and governmental organizations ratio scale 5 [very low,very high]

A.12 How important for your privacy is the stakeholder you share your mobile sensor data with? ratio scale 5 [not at all important,extremely im-
portant]

A.13 Which level of privacy-intrusion would you assign to the following contexts of apps with
access to your mobile sensor data?

group of questions 9 questions

A.13.1 Education ratio scale 5 [very low,very high]
A.13.2 Entertainment ratio scale 5 [very low,very high]
A.13.3 Environment ratio scale 5 [very low,very high]
A.13.4 Finance ratio scale 5 [very low,very high]
A.13.5 Health ratio scale 5 [very low,very high]
A.13.6 Shopping ratio scale 5 [very low,very high]
A.13.7 Social networking ratio scale 5 [very low,very high]
A.13.8 Training ratio scale 5 [very low,very high]
A.13.9 Transportation/Traveling ratio scale 5 [very low,very high]

A.14 How important is for your privacy the context of apps in which you share your mobile
sensor data?

ratio scale 5 [not at all important,extremely im-
portant]

A.15 Select one or more incentives which would motivate you to share your mobile sensor data multiple choice,
multiple selections

money, vouchers/discounts on services
and stores, free access to additional ser-
vices (maps, recommended apps, etc.),
free access to data, contributing to
public good, contributing data if my
friends did, contributing data without
incentives

The next screens personalize the sharing of sensor data. Initially, the three criteria of (i) sensor
type, (ii) data collector and (iii) context receive their weights according to the perception of each
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| | Placeholder for organisational unit name / logo 
(edit in slide master via “View” > “Slide Master”)  1.12.2014 First name Surname (edit via “Insert” > “Header & Footer”) 2 

Experimental Timetable 

 
 

Day 1 
05.12.16 

16:15-17:00 
Entry Phase 

Day 2 
Core Phase 

Day 3 
Core Phase  

Day 4 
08.12.16 

16:15-17:00 
Exit Phase 
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(edit in slide master via “View” > “Slide Master”)  1.12.2014 First name Surname (edit via “Insert” > “Header & Footer”) 3 

Entry Phase 

| | Placeholder for organisational unit name / logo 
(edit in slide master via “View” > “Slide Master”)  1.12.2014 First name Surname (edit via “Insert” > “Header & Footer”) 4 

Entry Phase 

•  Reading these instructions is a requirement. 
•  All requirements on the invitation e-mail need to be fulfilled to 

participate. If you don’t fulfill the requirements contact 
immediately the experiment moderators. 

•  You are not allowed to interact with other participants. 
•  Questions should only be addressed to the experiment 

moderators in private. 
. 
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Entry Phase – Download App 

1.  Download the app “COSS” from the Play 
Store.   

 
      Type “trialapp04 and find “COSS” 
 
! You have to turn off the battery 
optimization (Android 6) of the COSS app. 
 
Go to Settings          Battery    
App Power Saving / Battery Optimization 
Click on the COSS app       
Turned off / Not Optimized 
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Entry Phase – User Information 

1.  Open the “COSS” app 
2.  Start answering questions about user information 

Attention! 
 
! You can go back and re-answer questions, but once you press the                      button, the 
data cannot be changed.  
 

!  You cannot navigate to the next pages without filling out all questions. 
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Entry Phase – Classify Features 

1.  Classify how privacy-intrusive you find the 
following features. 

 
Sensor Type 
§  The different sensors collecting data:  

Location (GPS), noise, accelerometer, light.  

Data Collectors                                                                              
§  Third parties requesting access to sensor data: 

Corporation companies (Tagesanzeiger),  
Non-profit, non-governmental organizations (Swiss Made Software),  
Educational institutes (ETHZ),  
Governmental organizations (State Secretariat for Education, Research and 
Innovation)  

Contexts 
§  The purpose (app) for which sensor data are collected: 

Social networking, environment, transportation/travelling, health/fitness  
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Entry Phase – Classify Features 

 
There are five possible choices ranging from  

very low privacy intrusion to very high privacy intrusion. 
 

“very low privacy intrusion” 
This feature affects your privacy to your minimum 

 
“very high privacy intrusion” 

This feature affects your privacy to your maximum 
 

! All questions are compulsory, and required.  
No default option (None).  
 
! After pressing                    button, you cannot anymore 
change your selections 
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Entry Phase – Classify Sensors 

1.  Classify how privacy-intrusive you find each 
sensor . 

“very high privacy intrusion” 
These sensor data are privacy-intrusive to your maximum 

“very low privacy intrusion” 
These sensor data are privacy-intrusive to your minimum 

 

! All questions are compulsory, and required.  
No default option (None).  
 
! After pressing                    button, you cannot anymore 
change your selections 
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Entry Phase –  Classify Sensors 

Sensors 
 
Accelerometer records the velocity changes of your smartphone. 
 
Location/GPS measures the geographical location of your smartphone. 
 
Light measures the light level of your smartphone. 
 
Noise measures several sound features sampled from your microphone 
e.g. level of sound frequencies. 
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1.  Classify how privacy-intrusive you find each data 
collector. 

“very low privacy intrusion” 
This data collector is privacy-intrusive to your minimum 

“very high privacy intrusion” 
This data collector is privacy-intrusive to your maximum 

 

! All questions are compulsory, and required.  
No default option (None).  
 
! After pressing                    button, you cannot anymore 
change your selections 
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Entry Phase – Classify Contexts 

1.  Classify how privacy-intrusive you find each 
context. 

! All questions are compulsory, and required.  
No default option (None).  
 
! After pressing                    button, you cannot anymore 
change your selections 

“very low privacy intrusion” 
This context of data use is concerned low privacy-intrusive by you 

“very high privacy intrusion” 
This context of data use is concerned very privacy-intrusive by you 

 

| | Placeholder for organisational unit name / logo 
(edit in slide master via “View” > “Slide Master”)  1.12.2014 First name Surname (edit via “Insert” > “Header & Footer”) 14 

Entry Phase –  Answer Questions  

1.  Answer the next 64 questions 

“Maximum data” 
You share data collected at the highest frequency (more data) 

“No data” 
You share no data 

 

Data frequency : How often the data are collected  
 

Choice 1 : Every 30 seconds 
Choice 2 : Every 60 seconds 
Choice 3 : Every 90 seconds 

  Choice 4 : Every 120 seconds 
                              Choice 5 : No data 
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Entry Phase –  Answer Questions  

! All questions are compulsory, and required.  
 
! After pressing             submit  button, you cannot 
anymore change your selections 

The entry phase (Day 1) ends when you 
answer all the 64 questions. 
 

| | Placeholder for organisational unit name / logo 
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Entry Phase –  Answer Questions  
 
The entry phase (Day 1) finishes when this 
picture appears. The core phase starts that 
expands to Day 2 and Day 3.  
 
Day 2 lasts for the next 24 hours from now. 
Then you enter Day 3, which respectively lasts 
24 hours. 
 
Ask and read the instructions of the core 
phase before you further answer questions. 
 
 

Figure 1: Instructions presented to the participants starting with the entry phase.

participant on how privacy intrusive they are. The answers of the group Question B.9 in the
range ‘very low’ to ‘very high’ are mapped to the weights wi,u of the three criteria as illustrated in
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Figure 2: Information consent for participation in the designed experiment.

Section 1.2. Moving to the next screens, the same personalization process is repeated within each
criterion: for the different sensor types (group Question B.10), data collectors (group Question B.11)
and contexts (group Question B.12).

Table 5 illustrates the three criteria and its elements during the experiment. For each feature,
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(a) The Android app at Google Play (b) An instantiation of the factorial ques-
tion

Figure 3: Screens of the Android app during the entry phase.

four possible elements are selected in the factorial experiment to keep a manageable number of
4 ∗ 4 ∗ 4 = 64 total combinations.

The elements of the data-sharing criteria are chosen after scrutinizing the responses received by
the participants of the preparatory phase in Question A.9 for the sensor types (Figure 4a) as well
as Question A.13 and A.6 for the contexts (Figure 4b and 4c respectively). Two out of the top-3
highly privacy-intrusive sensors are selected. These are the GPS (privacy intrusion of 0.85) and
microphone (privacy intrusion of 0.78). The camera sensor is ranked 2nd with privacy intrusion
of 0.83. It is not selected as it requires the collection of more complex data and higher storage
space in the smartphones. The accelerometer (ranked 6th with privacy intrusion of 0.47) and light
(ranked 7th with privacy intrusion of 0.46) sensors are the other two ones selected that belong into
the middle ranking range of privacy intrusion.

Figure 3b illustrates an instantiation example of the factorial question. After answering all
questions, participants complete their participation in the entry phase and the smartphone app
initializes the core phase. They receive the instructions of the core phase and they depart from
DeSciL. Note that the answers to the instantiations of the factorial question during the entry phase
are not monetary rewarded. The answers to these questions are the baseline with which the rewarded
sharing of mobile sensor data during the core phase is compared.
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Table 4: Survey questions for the entry phase.
ID Question Type Options

B.1 Gender multiple choice,
one selection

male, female

B.2 Year of birth multiple choice,
one selection

81 [1920,2000]

B.3 Education level multiple choice,
one selection

less than high school, high school, some
college, bachelors degree, masters de-
gree, PhD degree

B.4 How concerned are you about the privacy of your mobile sensor
data?

ratio scale 5 [not at all,highly]

B.5 Employment status multiple choice,
one selection

full time, part time, not looking for
work, looking for work, retired, stu-
dent, disabled

B.6 In which country did you spend most of your life? multiple choice,
one selection

all countries

B.7 How often do you check your mobile phone a day? multiple choice,
one selection

<35, 36-70, 71-100, 101-135, >135

B.8 Which types of apps do you usually have on your smartphone? multiple choice,
multiple selections

education, entertainment, finance,
game, health & fitness, transportation
& navigation, music & audio, news,
productivity, shopping, social net-
working, medical, traveling, utilities,
weather

B.9 How intrusive are the following features of information sharing? group of questions 3 questions
B.9.1 Sensors multiple choice,

single selection
very low, low, medium, high, very high

B.9.2 Data collectors multiple choice,
single selection

very low, low, medium, high, very high

B.9.3 Context/Purpose multiple choice,
single selection

very low, low, medium, high, very high

B.10 How privacy intrusive is the data sharing of the following sensors? group of questions 4 questions
B.10.1 Accelerometer multiple choice,

single selection
very low, low, medium, high, very high

B.10.2 Location multiple choice,
single selection

very low, low, medium, high, very high

B.10.3 Light multiple choice,
single selection

very low, low, medium, high, very high

B.10.4 Noise multiple choice,
single selection

very low, low, medium, high, very high

B.11 How privacy intrusive are the following data collectors of your
mobile sensor data?

group of questions 4 questions

B.11.1 Corporations multiple choice,
single selection

very low, low, medium, high, very high

B.11.2 Non-governmental Organizations multiple choice,
single selection

very low, low, medium, high, very high

B.11.3 Governments multiple choice,
single selection

very low, low, medium, high, very high

B.11.4 Educational Institutes multiple choice,
single selection

very low, low, medium, high, very high

B.12 How privacy intrusive are the following contexts under which sen-
sor data is used by stakeholders?

group of questions 4 questions

B.12.1 Health/Fitness multiple choice,
single selection

very low, low, medium, high, very high

B.12.2 Social Networking multiple choice,
single selection

very low, low, medium, high, very high

B.12.3 Environment multiple choice,
single selection

very low, low, medium, high, very high

B.12.4 Transportation multiple choice,
single selection

very low, low, medium, high, very high

3.3 Core phase
The core phase is initialized right after the completion of the entry phase when participants also
receive the instructions shown in Figure 5. They also receive at this phase the instructions about
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Table 5: The selected elements in the criteria for sharing mobile sensor data.
Sensor Type Data Collector Context

GPS Corporation (Tagesanzeiger) Social networking
Microphone Non-profit, non-governmental organizations (Swiss Made Software) Environment
Accelerometer Educational institutes (ETH Zurich) Transportation/traveling
Light Governmental organizations (The State Secretariat for Education, Research and Innovation) Health/fitness
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(b) Contexts

Figure 4: Data used from Question A.9, A.13 (yellow bars, intrusion) and A.6 (red bars, probability)
of the preparatory phase for choosing the elements of the data-sharing criteria for the factorial
experiment.

the data-access portal, see Figure 6. The core phase lasts for two full days (48 hours, Mondays
to Tuesdays and Tuesdays to Wednesdays as shown in Table 2.). It takes place out of DeSciL lab
and integrates to the daily life of participants. At the beginning of each day in the core phase, the
rewards are zero as no data sharing is performed unless the participants consent to this via their
responses to the data-sharing scenarios.

3.4 Exit phase
The exit phase is performed on Thursdays, the 4th day of each experimental session (see Table 2),
and involves the return of the participants to DeSciL. The staff members of the lab verify the identify
of the participants and they are then seated to lab computers to fill in an online survey created in
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Figure 5: Instructions presented to the participants starting the core phase and after finishing the
entry phase.
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Figure 6: Instructions on the data-access portal presented to the participants starting the core phase
and after finishing the entry phase.

Qualtrics. The questions of the exit survey are outlined in Tables 6 to 9. The matching of the data
collected in this phase with the data of the previous phases is performed with the user ID inserted
in Question D.1.

The exit survey begins by acquiring general information about the mobile phone used during the
experiment as shown in Table 6. Questions about the user interface and functionality of the mobile
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Table 6: General survey questions for the exit phase.
ID Question Type Options

D.1 Please enter your unique ID number open-ended -

D.2 Which operating system and which version does your phone have (e.g. Android 6.0.1)? open-ended -

D.3 Which mobile phone model have you used for this experiment? open-ended -

Table 7: Survey questions for the exit phase–user interface and mobile app functionality.
ID Question Type Options

D.4 How easy was it to use the mobile app of the experiment? ratio scale 5 [extremely diffi-
cult,extremely easy]

D.5 How would you rate the quality of the app? ratio scale 5 [extremely
bad,extremely good]

D.6 How satisfied are you with each of the following features of the mobile app? group of ques-
tions

7 questions

D.6.1 Battery consumption ratio scale 5 [very low,very high]
D.6.2 Performance speed ratio scale 5 [very low,very high]
D.6.3 Colors ratio scale 5 [very low,very high]
D.6.4 Formulation of questions ratio scale 5 [very low,very high]
D.6.5 Content of questions ratio scale 5 [very low,very high]
D.6.6 Number of different questions ratio scale 5 [very low,very high]
D.6.7 Frequency of the notifications ratio scale 5 [very low,very high]

D.7 Please evaluate the following features of the mobile app: group of ques-
tions

12 questions

D.7.1 How comprehensible was the indicator of the rewards accumulated? (Arrow 1) ratio scale 5 [very little,very much]
D.7.2 How useful was the indicator of the rewards accumulated to make a choice? (Arrow 1) ratio scale 5 [very little,very much]
D.7.3 How comprehensible was the indicator of the total privacy level? (Arrow 2) ratio scale 5 [very little,very much]
D.7.4 How useful was the indicator of the total privacy level to make a choice? (Arrow 2) ratio scale 5 [very little,very much]
D.7.5 How comprehensible was the indicator of rewards payoff for each data-sharing level? (Arrow 3) ratio scale 5 [very little,very much]
D.7.6 How useful was the indicator of rewards payoff for each data-sharing level to make a choice? (Arrow 3) ratio scale 5 [very little,very much]
D.7.7 How comprehensible was the indicator of privacy payoff for each data-sharing level to make a choice? (Arrow 4) ratio scale 5 [very little,very much]
D.7.8 How useful was the indicator of privacy payoff for each data-sharing level to make a choice? (Arrow 4) ratio scale 5 [very little,very much]
D.7.9 How comprehensible were the five options of data sharing? (Arrow 5) ratio scale 5 [very little,very much]
D.7.10 How useful were the five options of data sharing? (Arrow 5) ratio scale 5 [very little,very much]
D.7.11 How comprehensible was the improvement box? (Arrow 6) ratio scale 5 [very little,very much]
D.7.12 How useful was the improvement box to make a choice? (Arrow 6) ratio scale 5 [very little,very much]

D.8 Do you have any other comments regarding the indicators? open-ended -

Table 8: Survey questions for the exit phase–privacy and rewards.
ID Question Type Options

D.9 Please evaluate the following questions about privacy: group of questions 4 questions
D.9.1 Did the experiment make you feel more aware of the privacy of mobile sensor data? ratio scale 5 [definitely not,definitely yes]
D.9.2 Did the values of privacy represent well your choices of privacy-preservation? ratio scale 5 [definitely not,definitely yes]
D.9.3 Could you easily adjust your total privacy when it was not satisfactory? ratio scale 5 [definitely not,definitely yes]
D.9.4 Did your privacy-preservation choices deserved the sacrifice of rewards? ratio scale 5 [definitely not,definitely yes]

D.10 How satisfied are you with the following? group of questions 2 questions
D.10.1 The total available amount of rewards (30 CHF) ratio scale 5 [extremely dissatisfied,extremely satisfied]
D.10.2 The amount of rewards you gained during experiment out of the total available amount of rewards ratio scale 5 [extremely dissatisfied,extremely satisfied]

D.11 Please evaluate the following statements about rewards: group of questions 5 questions
D.11.1 Did rewards convince you to share mobile sensor data? ratio scale 5 [definitely not,definitely yes]
D.11.2 Did rewards convince you to share more mobile sensor data than without rewards? ratio scale 5 [definitely not,definitely yes]
D.11.3 Did rewards make you more aware about the privacy of mobile sensor data? ratio scale 5 [definitely not,definitely yes]
D.11.4 Did rewards make you more aware about the value of mobile sensor data? ratio scale 5 [definitely not,definitely yes]
D.11.5 Did rewards choices deserved the sacrifice of privacy? ratio scale 5 [definitely not,definitely yes]

D.12 Evaluate the change in rewards payoff (Arrow 3) among the different data-sharing options ratio scale 5 [very low,very high]

D.13 Evaluate the change of privacy level payoff (Arrow 4) among the different data-sharing options. ratio scale 5 [very low,very high]

app are posed (Table 7). The ease of use and the quality of the app are evaluated in Questions D.4
and D.5 respectively, with the group Question D.6 evaluating the satisfaction level of several features
such as colors, formulation of questions, number of questions and others. The group Question D.7
evaluates how comprehensible and useful the user interface features are (Figure 9 in the main paper).
These questions are used to detect possible biases that may affect data-sharing choices. The questions
of Table 8 follow that concern the rewards and privacy. A few factors evaluated are the awareness
about privacy (Question D.9.1), ease of privacy adjustments (Question D.9.3), satisfaction level on
rewards (Question D.10), data-sharing incentivization by rewards (Question D.11) and other. These
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Table 9: Survey questions for the exit phase–experiment
ID Question Type Options

D.14 Have you participated before in the following: group of questions 3 questions
D.14.1 An experiment at ETH Decision Science Lab? multiple choice,

one selection
yes, no

D.14.2 A social experiment elsewhere? multiple choice,
one selection

yes, no

D.14.3 An experiment that requires the use of a mobile app? multiple choice,
one selection

yes, no

D.15 How interesting was the experiment? ratio scale 5 [not interesting at all,extremely interesting]

D.16 Would you participate in a similar experiment again? ratio scale 5 [definitely not,definitely yes]

D.17 How satisfied are you with the following: group of questions 6 questions
D.17.1 The written instructions given during the experimental process ratio scale 5 [extremely dissatisfied,extremely satisfied]
D.17.2 Your participation in the entry phase ratio scale 5 [extremely dissatisfied,extremely satisfied]
D.17.3 Your participation in the core phase ratio scale 5 [extremely dissatisfied,extremely satisfied]
D.17.4 Your participation in the exit phase ratio scale 5 [extremely dissatisfied,extremely satisfied]
D.17.5 The technical support of the staff members moderating the experiment ratio scale 5 [extremely dissatisfied,extremely satisfied]
D.17.6 Your participation in the overall experiment ratio scale 5 [extremely dissatisfied,extremely satisfied]

D.18 Has your mobile phone been turned off during the experiment? multiple choice,
one selection

yes, no

D.19 Have you run out of battery during the experiment? multiple choice,
one selection

yes, no

D.20 If yes, please provide some more information (e.g. how long, how many times,
at what time of the day)

open-ended -

D.21 Which of the following reasons prevented you from answering more questions? multiple choice,
multiple selection

I was not interested anymore, I was not
enough motivated, I faced technical prob-
lems, I ran out of battery, I was busy, I was
not satisfied by the experiment, I was con-
cerned about my privacy, other

D.22 Did you think at any time to drop out of the experiment? multiple choice,
one selection

yes, no

D.23 If yes, what was the reason? open-ended -

D.24 Did you experience any of the following technical problems? multiple choice,
multiple selection

application crashed, application froze, ap-
plication was too slow, network connection
problems, battery drain, other

D.25 Have you been aware of the Data Collection Portal? multiple choice,
one selection

yes, no

D.26 Have you ever visited the Data Collection Portal? multiple choice,
one selection

yes, no

D.27 How many times did you visit the Data Collection Portal? multiple choice,
one selection

never, less than three times, more than 3
times

D.28 Did you know about this experiment before participating? multiple choice,
one selection

yes, no

questions further explain the data-sharing choices made during the entry and core phase. Table 9
includes the following questions about the experimental process. They evaluate the satisfaction
level to several experimental aspects (Question D.17), the participation level and technical problems
(Questions D.18-D.24) as well as the user experience of the data-access portal (Questions D.25-D.27).

After the exit survey, participants have an interview with the moderators of the experimental
session. The goal of the interview is to scrutinize in a more qualitative way how participants
perceive the overall experimental process as well as to discuss some behavioral artifacts observed
in the data collected by the Kinvey backend during the previous phases. Moreover, when data
are not successfully transferred to Kinvey, the data are manually transferred from the participants’
phones to the moderators’ computers after participants’ consent. At the end of the interview, the
moderators compute and validate the final total compensation of each participant who receives the
compensation by the lab moderators before departing from DeSciL.
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3.5 Compensation and monetary incentives
The computed rewards are personalized according to the model of Section 1. The entry phase receives
higher compensation as it requires the initial engagement and the execution of more complex tasks
with the smartphone compared to the exit phase.

The distribution of the rewards for the app use follows a geometric progression and is implemented
by transforming Equation 7 as follows:

ri,j = r̂i,j · z−1

√
Bp

B

si,j−1

. (9)

where r̂i,j is the maximum rewards that can be gained in sharing scenario j computed by Equation 5,
z = 5 is the number of sharing options, si,j is the participant’s selection, Bp is the participation
budget and B is the total available budget.

The allocated amounts for the compensation of participants are decided empirically after con-
sultation with the DeSciL staff members. Factors that influence the decisions are the following: the
available budget, the target of employing around 100 participants, the complexity of the designed
experimental process, Swiss economy and the student profile of the participants in the DeSciL pool.
The amounts reflect a trade-off: high enough to inventivize and engage participants with this novel
experimental process while not too high to study data-sharing dilemmas between privacy and mon-
etary rewards. The effectiveness of the selected amounts is evaluated using Questions D.9-D.13 of
Table 8. These results show that the designed rewards were effective for their purpose. A 57.7%
of the participants were too busy to answer more questions, while 33.6% needed further motivation
(Question D.21).
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Figure 7: The assessment of the received rewards by the participants of the experiment using group
Questions D.10 and D.11.
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4 Implementation of the Technical Infrastructure
The data collected by participants’ smartphone app are stored and managed locally by an implemen-
tation of the nervousnet framework [2] that provides high-level application programming interfaces
(APIs) to store, query and analyze data on smartphones. Remotely on the server, the data are
stored and managed by Kinvey [3] that provides secure communication by using TLS/SSL encryp-
tion between smartphones and the Kinvey backend. The data-access web portal relies on Node.js
and a MongoDB database.

The quality of the app (Question D.5) is evaluated 61% positively. The mobile phone remained
turned on during the experiment in 82.7% of the participants (Question D.18), while only 13.8% of
the participants ran out of battery (Question D.19) and a 25.9% reported battery drain problems
(Question D.24).

5 The Privacy and Rewards Gain of Data-sharing Scenarios
Figure 8 illustrates the mean privacy and reward gain of the data-sharing scenarios retrieved as a
response of choosing to improve privacy and rewards respectively (see Figure 9 in the main paper).

Table 10 outlines the mean privacy and reward gain of the different data-sharing elements that
consist the 64 data-sharing scenarios.

Table 10: Mean privacy and reward gain of the different data-sharing elements involved in the
data-sharing scenarios.

Mean Gain acc lig noi gps cor ngo gov edu soc env tra hea

Privacy 4.75 1.92 1.4 1.36 3.13 2.56 2.02 1.71 2.5 2.3 2.29 2.33

Reward 0.16 0.16 0.16 0.19 0.18 0.16 0.17 0.16 0.18 0.16 0.16 0.16

6 Privacy Loss and Rewarded Data-sharing Choices of Groups
Figure 9a and 9b illustrate the probability and cumulative density functions for the intrinsic, 1st

and 2nd rewarded data sharing. The two experimental conditions for rewarded data sharing show
very similar densities, while intrinsic data sharing comes with a single peak around the privacy level
of 0.55.

Figure 9c shows the privacy level over consecutive data-sharing choices under the 2nd rewarded
data sharing. Compared to Figure 7b in the main paper showing the 1st rewarded data sharing, the
group behaviors are similar. Reward opportunists show a further decline of their privacy level.

7 Goal Signals for Coordinated Data Sharing
Figure 10 illustrates the five goal signals of privacy preservation. They represent a distribution of
required amount of data over the 64 data-sharing scenarios. They are referred within the range
of very high to very low privacy preservation. This is because each signal measures for each data-
sharing scenario the ratio of participants that choose a certain data-sharing level for this scenario
under intrinsic data sharing. Note that for each data-sharing scenario in Figure 10, the shares of
participants sum up to 1.
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(b) Reward gain of data-sharing scenarios

Figure 8: Mean privacy and reward gain for the 64 data-sharing scenarios under rewarded data
sharing. The scenarios are sorted from lowest to highest gain.

8 Data-sharing Mismatch
Figure 11 shows the data-sharing mismatch for the rest of the three goal signals of privacy preser-
vation: low, medium and high. The results here confirm the findings illustrated in Figure 3b of
the main paper: mismatch increases for higher privacy-preservation goals as agents mainly have one
privacy preserving option (intrinsic) to choose from.

9 Valuations of Collective Privacy Recovery
Four different valuations of privacy are compared in Table 11. All valuations are a function of ri
that is the mean privacy level over all data-sharing scenarios, measured by the gained rewards as
outlined in Equation 7:

• Absolute shared data: The privacy cost Ci(ri) equals the gained rewards ri. This is the
default valuation used throughout the main paper. The minimum privacy cost is 0, while
the maximum is 17.5 that is the maximum rewards that an individual could gain in the lab

18



 0

 0.2

 0.4

 0.6

 0.8

 1

 1.2

 1.4

 1.6

 1.8

 2

 0  0.2  0.4  0.6  0.8  1

P
ro
b
a
b
ili
ty

Privacy

Intrinsic
1st Rewarded
2nd Rewarded

(a) Probability density function of
privacy for intrinsic and rewarded
data sharing.

 0

 0.2

 0.4

 0.6

 0.8

 1

 0  0.2  0.4  0.6  0.8  1

P
ro
b
a
b
ili
ty

Privacy

Intrinsic
1st Rewarded
2nd Rewarded

(b) Cumulative density function of
privacy for intrinsic and rewarded
data sharing.

 0

 0.2

 0.4

 0.6

 0.8

 1

 0  50  100  150  200  250

unique repeated

P
ri
v
a
c
y
 [
R
e
w
a
rd
e
d
]

Data Sharing Scenarios

Reward opportunists
Privacy preservers
Privacy ignorants
Reward seekers
Privacy neutrals

(c) Mean privacy of groups over
consecutive rewarded data-sharing
choices.
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data-sharing choices under the 2nd rewarded data sharing.
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Figure 10: The five goal signals of privacy preservation: from very high to very low. For each signal,
the values of a data-sharing scenario measure the share of participants that choose a certain level of
privacy preservation.

experiment.

• Absolute sacrificed rewards: The privacy cost Ci(ri) equals the gained rewards ri minus
the fixed data-sharing rewards Bs. This scheme is equivalent to the absolute shared data as Bs

is constant. This valuation measures more directly the loss of rewards in exchange of privacy
preservation. The minimum privacy cost is −17.5, while the maximum one is 0.

• Relative shared data: The privacy cost Ci(ri) equals the gained rewards ri minus the privacy
level under intrinsic data sharing, measured as well in terms of (hypothetical) gained rewards
(r̃i). The privacy cost of this scheme measures the additional privacy loss under rewarded

19



 0

 0.2

 0.4

 0.6

 0.8

 1

n
o
i 
tr
a

 c
o
r

n
o
i 
h
e
a

 c
o
r

a
c
c
 h
e
a

 e
d
u

a
c
c
 s
o
c
 g
o
v

a
c
c
 t
ra

 g
o
v

n
o
i 
tr
a

 n
g
o

n
o
i 
e
n
v
 e
d
u

g
p
s
 h
e
a

 g
o
v

lig
 h
e
a

 n
g
o

g
p
s
 h
e
a

 e
d
u

g
p
s
 s
o
c
 c
o
r

a
c
c
 t
ra

 c
o
r

n
o
i 
h
e
a

 e
d
u

lig
 e
n
v
 g
o
v

a
c
c
 s
o
c
 e
d
u

a
c
c
 t
ra

 n
g
o

lig
 t
ra

 e
d
u

lig
 t
ra

 n
g
o

a
c
c
 e
n
v
 n
g
o

a
c
c
 h
e
a

 g
o
v

lig
 e
n
v
 c
o
r

a
c
c
 s
o
c
 n
g
o

g
p
s
 t
ra

 n
g
o

lig
 h
e
a

 g
o
v

n
o
i 
e
n
v
 g
o
v

g
p
s
 h
e
a

 n
g
o

a
c
c
 t
ra

 e
d
u

g
p
s
 e
n
v
 n
g
o

lig
 e
n
v
 e
d
u

n
o
i 
s
o
c
 n
g
o

n
o
i 
s
o
c
 e
d
u

n
o
i 
e
n
v
 n
g
o

g
p
s
 e
n
v
 c
o
r

g
p
s
 e
n
v
 e
d
u

g
p
s
 h
e
a

 c
o
r

n
o
i 
tr
a

 e
d
u

g
p
s
 e
n
v
 g
o
v

n
o
i 
h
e
a

 g
o
v

lig
 s
o
c
 c
o
r

lig
 e
n
v
 n
g
o

lig
 h
e
a

 e
d
u

lig
 t
ra

 g
o
v

n
o
i 
e
n
v
 c
o
r

n
o
i 
s
o
c
 g
o
v

lig
 h
e
a

 c
o
r

a
c
c
 h
e
a

 n
g
o

g
p
s
 s
o
c
 g
o
v

n
o
i 
tr
a

 g
o
v

g
p
s
 s
o
c
 e
d
u

g
p
s
 s
o
c
 n
g
o

a
c
c
 s
o
c
 c
o
r

a
c
c
 e
n
v
 e
d
u

lig
 t
ra

 c
o
r

a
c
c
 h
e
a

 c
o
r

n
o
i 
s
o
c
 c
o
r

n
o
i 
h
e
a

 n
g
o

g
p
s
 t
ra

 c
o
r

g
p
s
 t
ra

 g
o
v

lig
 s
o
c
 n
g
o

lig
 s
o
c
 e
d
u

lig
 s
o
c
 g
o
v

a
c
c
 e
n
v
 c
o
r

a
c
c
 e
n
v
 g
o
v

g
p
s
 t
ra

 e
d
u

D
a
ta
-s
h
a
ri
n
g

 M
is
m
a
tc
h

Ranked Data-sharing Scenarios

P
riv
a
c
y
-p
re
s
e
rva

tio
n

 G
o
a
l

H
ig
h

L
o
w

Data Sharing:
(a)

M
e
d
iu
m

Rewarded ε=34.6%
Intrinsic ε=23.6%

Coordinated ε=19.0%

 0

 0.2

 0.4

 0.6

 0.8

 1

a
c
c
 t
ra

 n
g
o

n
o
i 
tr
a

 c
o
r

n
o
i 
tr
a

 g
o
v

lig
 h
e
a

 n
g
o

a
c
c
 h
e
a

 n
g
o

a
c
c
 t
ra

 g
o
v

n
o
i 
tr
a

 n
g
o

a
c
c
 s
o
c
 c
o
r

lig
 s
o
c
 e
d
u

n
o
i 
e
n
v
 n
g
o

lig
 t
ra

 g
o
v

g
p
s
 h
e
a

 g
o
v

g
p
s
 e
n
v
 n
g
o

a
c
c
 h
e
a

 e
d
u

n
o
i 
s
o
c
 g
o
v

n
o
i 
s
o
c
 c
o
r

a
c
c
 h
e
a

 g
o
v

g
p
s
 s
o
c
 c
o
r

lig
 e
n
v
 n
g
o

lig
 h
e
a

 g
o
v

lig
 h
e
a

 e
d
u

lig
 s
o
c
 n
g
o

lig
 h
e
a

 c
o
r

a
c
c
 e
n
v
 c
o
r

n
o
i 
s
o
c
 e
d
u

a
c
c
 e
n
v
 n
g
o

n
o
i 
e
n
v
 e
d
u

a
c
c
 s
o
c
 g
o
v

lig
 t
ra

 e
d
u

a
c
c
 s
o
c
 e
d
u

lig
 s
o
c
 c
o
r

g
p
s
 e
n
v
 g
o
v

a
c
c
 t
ra

 e
d
u

g
p
s
 t
ra

 c
o
r

g
p
s
 h
e
a

 e
d
u

n
o
i 
h
e
a

 e
d
u

n
o
i 
tr
a

 e
d
u

a
c
c
 h
e
a

 c
o
r

lig
 t
ra

 n
g
o

a
c
c
 t
ra

 c
o
r

lig
 e
n
v
 e
d
u

n
o
i 
h
e
a

 n
g
o

g
p
s
 s
o
c
 g
o
v

g
p
s
 e
n
v
 c
o
r

n
o
i 
e
n
v
 c
o
r

a
c
c
 e
n
v
 e
d
u

n
o
i 
h
e
a

 c
o
r

lig
 e
n
v
 g
o
v

n
o
i 
s
o
c
 n
g
o

g
p
s
 e
n
v
 e
d
u

a
c
c
 e
n
v
 g
o
v

g
p
s
 h
e
a

 c
o
r

a
c
c
 s
o
c
 n
g
o

g
p
s
 s
o
c
 n
g
o

g
p
s
 h
e
a

 n
g
o

n
o
i 
e
n
v
 g
o
v

lig
 t
ra

 c
o
r

g
p
s
 s
o
c
 e
d
u

lig
 e
n
v
 c
o
r

g
p
s
 t
ra

 g
o
v

g
p
s
 t
ra

 e
d
u

n
o
i 
h
e
a

 g
o
v

g
p
s
 t
ra

 n
g
o

lig
 s
o
c
 g
o
v

Data Sharing:
(b) Rewarded ε=19.6%

Intrinsic ε=16.9%
Coordinated   ε=12.6%

 0

 0.2

 0.4

 0.6

 0.8

 1

g
p
s
 t
ra

 e
d
u

a
c
c
 t
ra

 e
d
u

lig
 t
ra

 g
o
v

g
p
s
 s
o
c
 e
d
u

a
c
c
 e
n
v
 e
d
u

g
p
s
 h
e
a

 g
o
v

n
o
i 
e
n
v
 c
o
r

a
c
c
 t
ra

 c
o
r

a
c
c
 t
ra

 g
o
v

a
c
c
 e
n
v
 g
o
v

g
p
s
 t
ra

 n
g
o

g
p
s
 h
e
a

 e
d
u

lig
 h
e
a

 n
g
o

g
p
s
 t
ra

 c
o
r

a
c
c
 h
e
a

 g
o
v

g
p
s
 h
e
a

 n
g
o

lig
 s
o
c
 n
g
o

a
c
c
 e
n
v
 c
o
r

n
o
i 
h
e
a

 c
o
r

a
c
c
 s
o
c
 e
d
u

lig
 h
e
a

 e
d
u

g
p
s
 t
ra

 g
o
v

lig
 h
e
a

 g
o
v

lig
 e
n
v
 c
o
r

lig
 t
ra

 n
g
o

n
o
i 
tr
a

 g
o
v

n
o
i 
e
n
v
 g
o
v

a
c
c
 s
o
c
 n
g
o

a
c
c
 h
e
a

 n
g
o

g
p
s
 e
n
v
 g
o
v

g
p
s
 s
o
c
 g
o
v

lig
 h
e
a

 c
o
r

lig
 s
o
c
 e
d
u

lig
 e
n
v
 g
o
v

n
o
i 
tr
a

 n
g
o

a
c
c
 e
n
v
 n
g
o

a
c
c
 h
e
a

 e
d
u

lig
 t
ra

 c
o
r

g
p
s
 e
n
v
 c
o
r

a
c
c
 h
e
a

 c
o
r

g
p
s
 s
o
c
 c
o
r

n
o
i 
s
o
c
 c
o
r

a
c
c
 t
ra

 n
g
o

a
c
c
 s
o
c
 c
o
r

g
p
s
 e
n
v
 n
g
o

n
o
i 
e
n
v
 e
d
u

n
o
i 
h
e
a

 g
o
v

lig
 s
o
c
 g
o
v

n
o
i 
tr
a

 e
d
u

lig
 e
n
v
 e
d
u

n
o
i 
s
o
c
 e
d
u

lig
 e
n
v
 n
g
o

n
o
i 
h
e
a

 n
g
o

n
o
i 
h
e
a

 e
d
u

n
o
i 
e
n
v
 n
g
o

lig
 t
ra

 e
d
u

n
o
i 
s
o
c
 g
o
v

lig
 s
o
c
 c
o
r

n
o
i 
s
o
c
 n
g
o

g
p
s
 s
o
c
 n
g
o

a
c
c
 s
o
c
 g
o
v

g
p
s
 e
n
v
 e
d
u

n
o
i 
tr
a

 c
o
r

g
p
s
 h
e
a

 c
o
r

Data Sharing:
(c) Rewarded ε=14.8%

Intrinsic ε=15.8%
Coordinated   ε=9.1%

Figure 11: Data-sharing mismatch (root mean square error ε) for the 64 data-sharing scenarios
and for the three goal signals of high, medium and low privacy preservation. Values are sorted from
lowest to highest mismatch according to the the coordinated data sharing. Coordinated data sharing
shows higher efficiency than intrinsic and rewarded data sharing.

Table 11: Four valuation schemes and their range of values.

Valuation Relation min/max r̃i
Without Rewards (ri ≡ r̃i) With Rewards

min Ci(0) max Ci(17.5) min Ci(0) max Ci(17.5)

Absolute shared data Ci(ri) = ri 0 17.5 0 17.5
Absolute sacrificed rewards Ci(ri) = ri −Bs -17.5 0 -17.5 0

Relative shared data Ci(ri) = ri − r̃i r̃i = 0 0 0 0 17.5
r̃i = 17.5 0 0 -17.5 0

Relative sacrificed rewards Ci(ri) = ri − (Bs − r̃i) r̃i = 0 -17.5 -17.5 -17.5 0
r̃i = 17.5 -17.5 17.5 0 17.5

data sharing over the intrinsic one, assuming that the intrinsic data sharing comes with no
privacy cost. Depending on the level of intrinsic data sharing, the minimum privacy cost is
−17.5, while the maximum is 17.5 (the behavior of reward opposer and reward opportunist
respectively as shown in Table 1 of the main paper).
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• Relative sacrificed rewards: The privacy cost Ci(ri) equals the gained rewards ri minus
the privacy preservation under intrinsic data sharing measured by Bs − r̃i. This scheme is
equivalent to the one of absolute sacrificed rewards with the addition of the privacy cost r̃i
under intrinsic data sharing. Depending on the level of intrinsic data sharing, the minimum
privacy cost is −17.5, while the maximum one is 17.5.

The collective privacy recovery under intrinsic, rewarded and coordinated data sharing is assessed
using the four different valuations schemes under the very high and very low privacy preservation
goal. Figure 12 shows the privacy cost per individual for each of these cases. All lines are sorted from
lowest to highest privacy cost. Each plot in Figure 12 comes with the mean relative privacy gain and
loss of the coordinated data sharing compared to rewarded and intrinsic data sharing respectively.
The privacy cost of intrinsic data sharing corresponds to the data-sharing plan with the minimum
privacy cost and it is calculated using EPOS with α = 0, β = 1. In contrast, the privacy cost of
rewarded data sharing corresponds to the data-sharing plan with the maximum privacy cost and it
is calculated using EPOS with α = 0, β = 1 and data-sharing plans with reversed sign.
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Figure 12: The four privacy valuations illustrated in Table 11. The privacy cost is measured for
the intrinsic, rewarded and coordinated data sharing under the very high and very low privacy
preservation goal. The highest privacy gain is observed for the relative shared data and the relative
sacrificed rewards.

The highest privacy gains are observed under the valuation scheme of relative shared data: 54%
and 55.6% for the very high and very low privacy preservation goal. This means that coordinated
data sharing shows a further privacy recovery when evaluating the data-sharing choices based on the
additional privacy cost that individuals pay over the intrinsic data sharing. The relative sacrificed
rewards follow with 43.1% and 47.2% respectively. The default valuation scheme of absolute shared
data has the lowest privacy gain of 41.4% and 43.7% respectively, which equals the absolute sacrificed
rewards as Bs is constant (lines shifted to negative values). The mean privacy gain for the very low
privacy preservation goal is 2.7% higher than the very high one. Similarly with the observation
in Figure 3a of the main paper, two rewarded options of individuals with low privacy on average
provide higher flexibility than a single one with high privacy preservation.

With their higher privacy gains, the alternative valuation schemes find applicability in the fur-
ther adoption of the data-sharing plans recommended to users. They can also be used to provide
augmented explanations of what these recommended plans mean for the data collective, while raising
awareness of the different privacy manifestations and collective privacy gains.
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10 Privacy Reinforcement
Figure 13 illustrates the privacy reinforcement of the different data-sharing elements. The key finding
is that the perceived privacy sensitivity of the data-sharing elements is likely to reinforce privacy
under intrinsic and coordinated data sharing rather than the rewarded ones.
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Figure 13: Privacy reinforcement of the different sensors, collectors and contexts under intrinsic, re-
warded and coordinated data sharing. The 12 colored lines are ranked according to the reinforcement
change (intrinsic - 1st rewarded data sharing).

The mean absolute privacy reinforcement under intrinsic data sharing is higher than 1st re-
warded and the two coordinated data-sharing conditions: 4%>2.27%> 2.24%>0.65% respectively.
Under intrinsic data sharing, social networking, corporation, noise sensor and NGO reinforce pri-
vacy gain, while education, accelerometer and transportation a privacy loss. Privacy reinforcement
under intrinsic data sharing is correlated with the attitudinal privacy sensitivity (R = 0.63, t(10) =
2.57, p = 0.028). This means that privacy risk awareness is likely to reinforce privacy protection.
There is a correlation in the privacy reinforcement under intrinsic and the 1st rewarded data sharing
(R = 0.73, t(10) = 3.4, p = 0.0067). In the 2nd rewarded data sharing, GPS shifts to a 3.5% rein-
forcement of privacy loss, while environment shifts to a 8.4% reinforcement of privacy gain. Coordi-
nated data sharing with the very low privacy-preservation goal is positively correlated to attitudinal
(R = 0.65, t(10) = 3.68, p = 0.023), intrinsic (R = 0.96, t(10) = 11.58, p = 4.07× 10−7) and the 1st

rewarded (R = 0.62, t(10) = 2.48, p = 0.032) data sharing. With the very high privacy-preservation
goal, the correlation to attitudinal data sharing is negative: R = −0.61, t(10) = −2.43, p = 0.035.

11 Conjoint Analysis
The assumptions of conjoint analysis are discussed and assessed in the context of the conducted
experiment [4]. No direct carryover effects are involved under instinct data sharing as participants
are exposed to each data-sharing scenario once. Under rewarded data sharing, the privacy-rewards
balance introduces a carryover effect that is subject of study in this paper. Because rewards are
personalized (i.e. each data-sharing scenario is retrieved to satisfy the intended action of improving
rewards or privacy) and because responses to repeated data-sharing scenarios are made on-demand,
carryover effects mainly originate from tuning the privacy-rewards balance. No influential order
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effects are anticipated within the designed rating-based conjoint experiment. In regards to the
order of the data-sharing elements, each data-sharing scenario is presented in natural language as
determined by the Factorial Question in Section 4.1 of the main paper. Decision-making quality
is not expected to decrease for k = 3 < 10 data-sharing criteria as shown in earlier experimental
tests in literature [5, 4]. As this is not a choice-based conjoint experiment, the order of the data-
sharing levels (Figure 9b of the main paper) simply adheres to design principles of likert scales
and graphical user interfaces. As the experiment relies on a full-factorial design without rendering
any data-sharing scenario as infeasible, order effects among the scenarios are unlikely. It is though
personalization under rewarded data sharing that can yield, in theory, atypical data-sharing choices,
i.e. one that can increase the accumulated rewards when a participant chooses to improve privacy,
and vice versa. Excluding these or reducing the likelihood of their occurrence is expected to improve
external validity [4], i.e. participants do not lose interest or react contrary to their privacy-reward
goal improvement.

The performed conjoint analysis relies on the following multiple linear regression model:

λ0,0 + λ1,1 · D1,1 + ...+ λ1,l1−1 · D1,l1−1 + ...+ λk,lk−1 · Dk,lk−1 + ε (10)

where λu,o for each of the criteria u ∈ {1, ..., k} and elements o ∈ {1, ..., lk − 1} are the estimated
coefficients of the regression model, with λ0,0 representing the intercept and ε the regression error.
The Du,o for each of the criteria u ∈ {1, ..., k} and elements o ∈ {1, ..., lk − 1} are the independent
dummy variables that represent the absence or presence of a data-sharing element within a data-
sharing scenario. Note that one data-sharing element for each criterion is removed from the model
(accelerometer, corporation, social networking) to resolve the linear dependency with which the
effect of the confounded variables cannot be separated by the regression.

Using the estimated coefficients, the partworth utilities can be estimated for each data-sharing
criterion u as follows:

Pu =
maxluo=1 λu,o −minluo=1 λu,o∑k

u=1(maxluo=1 λu,o −minluo=1 λu,o)
. (11)

The partworth utilities measure the relative importance of the criteria within a regression model:
which of the data type, collector or context is the most important when individuals make data-
sharing decisions. Similarly, the relative importance of each data-sharing element for each criterion
is calculated as follows:

Pu,o =
λu,o − 1

lu
·∑lu

o=1 λu,o∑k
u=1(maxluo=1 λu,o −minluo=1 λu,o)

. (12)

The relative importance calculation can be adjusted for each data-sharing element among all criteria
as follows:

P̂u,o =
λu,o − 1

k·lu ·
∑k

u=1

∑lu
o=1 λu,o

maxku=1 maxluo=1 λu,o −minku=1 minluo=1 λu,o
. (13)

The model of Equation 10 is evaluated at the population level for different dependent variables
of privacy Pj and rewards Rj with values over the 64 data-sharing scenarios. These variables are
selected among the different experimental conditions and they determine the compared conjoint
analysis models. The regression coefficients are illustrated in Table 12 and Figure 14. The rest of
the conjoint analysis and metrics are shown in Table 13.
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Table 12: The coefficients λu,o of nine multiple regression models, each with a different dependent
variable of privacy or rewards. The four statistically more powerful models (R2>0.8) are illustrated
in the main paper. These values are used to analyze the relative importance of data-sharing criteria
and elements in Table 13.
Models acc lig noi gps cor ngo gov edu soc env tra hea Intercept

Privacy 0 0.023972603 0.087756849 0.043450342 0 -0.023116438 -0.058861301 -0.125856164 0 -0.084974315 -0.099957192 -0.088827055 0.654430651
[Intrinsic]

Privacy 0 0.006753024 0.013699034 -0.001945327 0 0.008754161 0.002140409 -0.018011013 0 -0.045397867 -0.050165302 -0.019421827 0.343937021
[1st Rewarded]

Privacy 0 0.018454293 0.024093745 -0.031555723 0 0.009563823 -0.015594024 0.006242213 0 0.039665329 -0.02786132 -0.022817284 0.310195822
[2nd Rewarded]

Rewards 0 -0.0000117 0.005297903 0.033532185 0 -0.013561209 -0.0074504 -0.018137996 0 -0.022210396 -0.015665036 -0.020453195 0.180147342
[1st & 2nd Rewarded]

Privacy 0 0.017219578 0.074057816 0.045395669 0 -0.031870599 -0.061001711 -0.107845152 0 -0.039576448 -0.04979189 -0.069405228 0.31049363
[Intrinsic − 1st Rewarded]

Privacy 0 0.00551831 0.063663104 0.075006065 0 -0.032680261 -0.043267278 -0.132098377 0 -0.124639644 -0.072095871 -0.066009771 0.344234829
[Intrinsic − 2nd Rewarded]

Privacy 0 -0.011701269 -0.010394712 0.029610396 0 -0.000809662 0.017734433 -0.024253226 0 -0.085063196 -0.022303981 0.003395458 0.033741198
[1st − 2nd Rewarded]

Privacy 0 0.003576389 0.037118056 0.023663194 0 -0.002256944 -0.024444444 -0.061510417 0 -0.025625 -0.045746528 -0.047048611 0.555911458
[Coordinated, very low]

Privacy 0 0.012326389 -0.006076389 -0.009027778 0 0.007118056 0.005034722 0.014930556 0 -0.000868056 -0.008680556 0.001215278 0.489479167
[Coordinated, very high]

Table 13: Conjoint analysis based on nine multiple linear regression models, each with a different
dependent variable of privacy or rewards. The four statistically more powerful models (R2>0.8)
are illustrated in the main paper. The table also shows all calculated partworth utilities (relative
importance [%]) and their significance.
Models Regression statistics Conjoint statistics Sensor Collector Context acc lig noi gps cor ngo gov edu soc env tra hea

Multiple R: 0.93 Pu 27.99 40.14 31.88
Privacy R2: 0.86 Pu,o -12.37 -4.73 15.61 1.48 16.57 9.20 -2.20 -23.57 21.83 -5.27 -10.05 -6.50
[Intrinsic] Adjusted R2: 0.84 P̂u,o 8.67 16.32 36.66 22.53 8.67 1.30 -10.10 -31.46 8.67 -18.42 -23.20 -19.65

ANOVA p-value: 5.43× 10−20 p-value: 0 0.031 6.67× 10−11 1.86× 10−4 0 0.037 1.34× 10−6 2.55× 10−16 0 1.73× 10−10 1.07× 10−12 4.62× 10−11

Multiple R: 0.78 Pu 16.90 28.91 54.19
Privacy R2: 0.61 Pu,o -5.00 2.30 9.80 -7.10 1.92 11.38 4.23 -17.53 31.05 -17.99 -23.14 10.07
[1st Rewarded] Adjusted R2: 0.55 P̂u,o 9.33 16.62 24.12 7.22 9.33 18.78 11.64 -10.13 9.33 -39.71 -44.86 -11.65

ANOVA p-value: 1.47× 10−8 p-value: 0 0.348 0.060 0.786 0 0.225 0.765 0.015 0 4.40× 10−8 3.63× 10−9 0.009

Multiple R: 0.85 Pu 37.52 16.96 45.52
Privacy R2: 0.73 Pu,o -1.85 10.59 14.39 -23.13 -0.04 6.41 -10.55 4.17 1.86 28.60 -16.93 -13.53
[2nd Rewarded] Adjusted R2: 0.68 P̂u,o -0.01 12.43 16.23 -21.28 -0.01 6.44 -10.52 4.20 -0.01 26.73 -18.79 -15.39

ANOVA p-value: 2.77× 10−12 p-value: 0 0.033 0.006 4.59× 10−4 0 0.263 0.071 0.464 0 1.90× 10−5 0.002 0.009

Multiple R: 0.97 Pu 45.40 24.55 30.06
Rewards R2: 0.93 Pu,o -13.13 -13.15 -5.96 32.25 13.25 -5.11 3.16 -11.30 19.73 -10.32 -1.47 -7.95
[1st & 2nd Rewarded] Adjusted R2: 0.92 P̂u,o 6.62 6.60 13.79 52.00 6.62 -11.74 -3.47 -17.93 6.62 -23.44 -14.58 -21.06

ANOVA p-value: 3.47× 10−28 p-value: 0 0.995 6.19× 10−3 1.62× 10−24 0 1.37× 10−9 1.90× 10−4 1.63× 10−13 0 8.77× 10−17 2.05× 10−11 2.10× 10−15

Multiple R: 0.85 Pu 29.47 42.91 27.62
Privacy R2: 0.72 Pu,o -13.60 -6.74 15.87 4.47 19.97 7.29 -4.31 -22.95 15.79 0.05 -4.02 -11.82
[Intrinsic − 1st Rewarded] Adjusted R2: 0.68 P̂u,o 7.39 14.24 36.86 25.45 7.39 -5.29 -16.89 -35.52 7.39 -8.36 -12.42 -20.23

ANOVA p-value: 3.65× 10−12 p-value: 0 0.194 5.92× 10−7 0.001 0 0.018 2.09× 10−5 3.99× 10−11 0 0.004 3.62× 10−4 2.15× 10−6

Multiple R: 0.91 Pu 22.61 39.82 37.57
Privacy R2: 0.82 Pu,o -10.87 -9.20 8.32 11.74 15.68 5.83 2.64 -24.14 19.80 -17.77 -1.93 -0.10
[Intrinsic − 2nd Rewarded] Adjusted R2: 0.79 P̂u,o 8.20 9.87 27.39 30.81 8.20 -1.65 -4.84 -31.62 8.20 -29.37 -13.53 -11.69

ANOVA p-value: 4.95× 10−17 p-value: 0 0.681 1.47× 10−5 7.10× 10−7 0 0.018 0.002 1.04× 10−13 0 7.65× 10−13 1.57× 10−6 7.97× 10−6

Multiple R: 0.83 Pu 24.05 24.45 51.50
Privacy R2: 0.69 Pu,o -1.09 -7.91 -7.15 16.15 1.07 0.60 11.39 -13.05 15.13 -34.39 2.15 17.11
[1st − 2nd Rewarded] Adjusted R2: 0.63 P̂u,o 5.04 -1.78 -1.02 22.28 5.04 4.56 15.36 -9.09 5.04 -44.49 -7.95 7.01

ANOVA p-value: 8.70× 10−11 p-value: 0 0.289 0.346 0.009 0 0.941 0.110 0.031 0 2.21× 10−10 0.046 0.757

Multiple R: 0.92 Pu 25.48 42.22 32.30
Privacy R2: 0.84 Pu,o -11.04 -8.59 14.44 5.20 15.14 13.59 -1.64 -27.09 20.32 2.73 -11.08 -11.97
[Coordinated, very low] Adjusted R2: 0.81 P̂u,o 8.14 10.59 33.62 24.38 8.14 6.59 -8.64 -34.09 8.14 -9.45 -23.26 -24.16

ANOVA p-value: 2.52× 10−18 p-value: 0 0.544 4.77× 10−8 1.68× 10−4 0 0.701 1.08× 10−4 1.13× 10−14 0 5.51× 10−5 1.94× 10−10 8.48× 10−11

Multiple R: 0.53 Pu 46.24 32.33 21.43
Privacy R2: 0.28 Pu,o 1.50 28.20 -11.65 -18.05 -14.66 0.75 -3.76 17.67 4.51 2.63 -14.29 7.14
[Coordinated, very high] Adjusted R2: 0.16 P̂u,o -2.88 23.81 -16.04 -22.43 -2.88 12.53 8.02 29.45 -2.88 -4.76 -21.68 -0.25

ANOVA p-value: 2.51× 10−2 p-value: 0 0.062 0.352 0.169 0 0.276 0.440 0.025 0 0.894 0.185 0.852

Eight models with privacy as the dependent variable as assessed: intrinsic, 1st, 2nd rewarded,
intrinsic−1st rewarded, intrinsic−2nd rewarded, 1st rewarded−2nd rewarded, coordinated for very low
and very high privacy preservation. One model with rewards as the dependent variable is assessed:
1st and 2nd rewarded of those individuals who intent and do improve rewards as in Figure 9 in the
main paper. In addition, the following four models with the mismatch as dependent variable are
assessed: intrinsic, rewarded, coordinated from very low to very high privacy preservation. As they
statistically perform poorly, they are not shown in Table 13.

Figure 15 illustrates the relative importance (Pu, P̂u,o) of the data-sharing criteria and elements
among all criteria, in contrast to Figure 6 in the main paper that shows the relative importance (Pu,
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Figure 14: Coefficients of multiple linear regression used in conjoint analysis. Nine models with
different dependent variables for privacy and rewards are compared. Four of these models with
R2 > 0.8 are shown in the main paper, Figure 6a.

Pu,o) of the elements within each criterion.
The relative importance (Pu) of the data-sharing criteria is the same as shown in Figure 6 of the

main paper. For all models, sensor data such as GPS (46.82%), noise (41.4%) and light (16.04%)
show the highest mean positive relative importance among all elements of the three criteria, while
education (-42.74%) from collectors and environment (-29.78%), health (-27.8%) and transportation
(-27.35%) from context show the lowest one. In contrast to the regression models, the perceived
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Figure 15: The relative importance (partworth utilities) of the data-sharing criteria and elements
(relative among all criteria) derived from the different regression models of conjoint analysis and the
perceived privacy sensitivity.

privacy sensitivity of GPS (44.37%), corporation (27.8%) and social networking (51.44%) are the
highest positive ones, while the accelerometer (-44.28%), light (-48.56%) and education (-25.51%)
show the highest negative ones.

12 Validation of Groups
Table 14 illustrates the results of the bootstrap evaluation method for the 5 different group behaviors
extracted from the experimental data.

Table 14: Results of the bootstrap evaluation method [6] (clusterboot of R) for the stability of
the clusters. Each entry of results is represented as ‘bootmean (bootbrd)’, where bootmean is the
clusterwise mean Jaccard similaritiy and bootbrd is the clusterwise number of times a cluster is
disolved.

Clustering algorithms k-means hierachical pamkCBI

Privacy ignorants 0.79 (8) 0.67 (41) 0.58 (48)
Privacy neutrals 0.93 (0) 0.88 (1) 0.7 (31)
Privacy preservers 0.89 (7) 0.76 (16) 0.7 (31)
Rewards seekers 0.83 (1) 0.75 (17) 0.61 (37)
Rewards opportunists 0.84 (6) 0.76 (14) 0.56 (51)

Furthermore, the split of the participants over the data-sharing groups is compared to privacy
categories identified in the general population from studies such as the ones of Westin [7, 8]. This
comparison can only be indicative though: a random sample from a US population back in 1990 is
compared to a non-random sample from a Swiss population in 2016. Moreover, the survey questions
are not identical to the formulated data-sharing prompts. Nevertheless, this comparison has a value
out of the the fact that there are groups that capture the intended privacy of a broader population
vs. groups that capture the actual data-sharing decisions of typical smartphone users.
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Westin’s studies classify individuals in three behavioral categories based on survey responses:
privacy fundamentalists, pragmatists and unconcerned. They cover the whole spectrum of data-
sharing levels depicted in the exemplary of Table 1 in the main paper. Based on this, we match
the data-sharing groups to Westin’s categories under intrinsic data sharing, i.e. the data-sharing
behavior of individuals is not considered under rewarded data sharing. The matching is illustrated
in Table 15. The observed groups sizes show a remarkable match to Westin’s privacy categories.

Table 15: Matching the Westin’s classification [7, 8] to the data-sharing groups without rewards
(Table 1 in this main paper).

Westin’s population categories [7, 8] Data-sharing Groups (n = 84).

Privacy fundamentalists 25% Privacy preservers 26.2%Reward opportunists

Privacy pragmatists 57% Privacy neutrals 57.14%Reward seekers

Privacy unconcerned 18% Privacy ignorants 16.7%

13 Analysis of Variance for Data-sharing Criteria and Groups
The Analysis of Variance (ANOVA) is made with IBM SPSS 24.0. Figure 16 summarizes the
p values obtained for each data-sharing criterion and its elements. Using the Levene’s test, the
homogeneity of variances is confirmed (p > 0.05) for the majority of the data-sharing criteria and
their elements: sensor (p = 0.169), data collector (p = 0.328), context (p = 0.956), GPS (p = 0.156),
light (p = 0.896), noise (p = 0.432), corporation (p = 0.607), educational institute (p = 0.35),
government (p = 0.074), NGO (p = 0.993), health (p = 0.314), social networking (p = 0.486).
It is not confirmed for: accelerometer (p = 0.04), transportation (p = 0.039) and environment
(p = 0.005). The whole report analysis is illustrated in Table 16.

The report analysis of the post hoc Tukey’s range test (α = 0.05) is illustrated in Table 17, 18
and 19.

References
[1] Qualtrics. URL https://www.qualtrics.com.

[2] Pournaras, E., Moise, I. & Helbing, D. Privacy-preserving ubiquitous social mining via mod-
ular and compositional virtual sensors. In Advanced Information Networking and Applications
(AINA), 2015 IEEE 29th International Conference on, 332–338 (IEEE, 2015).

[3] Mobile app backend development framework. URL https://www.progress.com/kinvey.

[4] Hainmueller, J., Hopkins, D. J. & Yamamoto, T. Causal inference in conjoint analysis: Under-
standing multidimensional choices via stated preference experiments. Political analysis 22, 1–30
(2014).

[5] Malhotra, N. K. Information load and consumer decision making. Journal of consumer research
8, 419–430 (1982).

27



 0

 0.2

 0.4

 0.6

 0.8

 1

c
o
n
te
x
t 

e
n
v
ir

o
n
m

e
n
t

h
e
a
lt

h

so
ci

a
l 

n
e
tw

o
rk

in
g

tr
a
n
sp

o
rt

a
ti

o
n

d
a
ta

 
c
o
ll
e
c
to
r

co
rp

o
ra

ti
o
n

e
d

u
ca

ti
o
n

g
o
v
e
rn

m
e
n
t

n
g

o

s
e
n
s
o
r

a
cc

e
le

ro
m

e
te

r

g
p

s

lig
h
t

n
o
is

e
S
ig

n
ifi

ca
n
ce

 
 T

h
re

sh
o
ld

p
 v

a
lu

e

Figure 16: Statistical significance (p values) of the different data-sharing criteria and their elements to
explain the 5 group behaviors in data sharing. Data collectors and sensors are significant (p < 0.05
values), in particular the GPS, as well as the transportation context. Moreover, the following
data-sharing elements fall close to the significance threshold: environment, and education contexts,
accelerometer and noise sensors, and the educational institutes as data collector.

[6] Hennig, C. Cluster-wise assessment of cluster stability. Computational Statistics & Data Analysis
52, 258–271 (2007).

[7] Westin, A. Harris Louis & Associates. Harris-Equifax Consumer Privacy Survey. Tech. Rep.,
Tech. rep, Conducted for Equifax Inc. 1,255 adults of the US public (1991).

[8] Kumaraguru, P. & Cranor, L. F. Privacy indexes: a survey of Westin’s studies (Carnegie Mellon
University, School of Computer Science, 2005).

28



Table 16: One-way ANOVA report analysis. Dependent variables: Questions B.9-B12 in Table 4.
Independent variable: The privacy change when groups’ data-sharing choices are rewarded.
Data Sharing Criterion Sum of Squares Degrees of Freedom (df) Mean Squares F-test Significance

Sensors
Between 10.745 4 2.686 2.756 0.031
Within 107.202 110 0.975
Total 117.948 114

Accelerometer
Between 6.083 4 1.521 1.774 0.139
Within 94.317 110 0.857
Total 100.4 114

Location
Between 8.805 4 2.201 2.719 0.033
Within 89.056 110 0.81
Total 97.861 114

Light
Between 0.838 4 0.21 0.241 0.914
Within 95.509 110 0.868
Total 96.348 114

Noise
Between 14.293 4 3.573 2.384 0.056
Within 164.873 110 1.499
Total 179.165 114

Data collectors
Between 9.85 4 2.463 2.862 0.027
Within 94.637 110 0.86
Total 104.487 114

Corporations
Between 2.019 4 0.505 0.399 0.809
Within 140.559 111 1.266
Total 142.578 115

NGOs
Between 5.426 4 1.356 1.199 0.315
Within 125.566 111 1.131
Total 130.991 115

Goverments
Between 3.322 4 0.831 0.534 0.711
Within 172.566 111 1.555
Total 175.888 115

Educational institutes
Between 7.881 4 1.97 2.27 0.066
Within 96.36 111 0.868
Total 104.241 115

Context/purpose
Between 2.056 4 0.514 0.532 0.712
Within 106.24 110 0.966
Total 108.296 114

Health/fitness
Between 12.013 4 3.003 2.158 0.078
Within 154.496 111 1.392
Total 166.509 115

Social networking
Between 1.468 4 0.367 0.495 0.74
Within 82.325 111 0.742
Total 83.793 115

Environment
Between 7.606 4 1.901 2.08 0.088
Within 101.455 111 0.914
Total 109.06 115

Transport
Between 12.589 4 3.147 2.779 0.03
Within 125.713 111 1.133
Total 138.302 115
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Table 17: Post hoc Tukey’s range test (α = 0.05) on sensors explaining the privacy change when
groups’ data-sharing choices are rewarded.

95% Confidence Interval
Data Sharing Criterion Mean Group Differences Standard Deviation Error Significance Lower Bound Upper Bound

Sensors

reward seekers - privacy ignorants 0.058 0.301 1.0 -0.78 0.89
privacy neutrals - privacy ignorants 0.779 0.314 0.102 -0.09 1.65
privacy neutrals - reward seekers 0.721 0.243 0.03 0.05 1.4
privacy preservers - privacy ignorants 0.511 0.416 0.735 -0.64 1.67
privacy preservers - reward seekers 0.453 0.366 0.729 -0.56 1.47
privacy preservers - privacy neutrals -0.268 0.377 0.953 -1.31 0.78
reward opportunists - privacy ignorants 0.233 0.325 0.952 -0.67 1.13
reward opportunists - reward seekers 0.175 0.257 0.96 -0.54 0.89
reward opportunists - privacy neutrals -0.546 0.272 0.271 -1.3 0.21
reward opportunists - privacy preservers -0.278 0.386 0.952 -1.35 0.79

Accelerometer

reward seekers - privacy ignorants 0.438 0.283 0.536 -0.35 1.22
privacy neutrals - privacy ignorants 0.703 0.294 0.126 -0.11 1.52
privacy neutrals - reward seekers 0.266 0.23 0.776 -0.37 0.9
privacy preservers - privacy ignorants 0.1 0.378 0.999 -0.95 1.15
privacy preservers - reward seekers -0.338 0.33 0.844 -1.25 0.58
privacy preservers - privacy neutrals -0.603 0.34 0.392 -1.55 0.34
reward opportunists - privacy ignorants 0.35 0.305 0.78 -0.5 1.2
reward opportunists - reward seekers -0.088 0.243 0.996 -0.76 0.59
reward opportunists - privacy neutrals -0.353 0.256 0.64 -1.06 0.36
reward opportunists - privacy preservers 0.25 0.349 0.952 -0.72 1.22

Location

reward seekers - privacy ignorants 0.733 0.275 0.066 -0.03 1.5
privacy neutrals - privacy ignorants 0.837 0.286 0.033 0.04 1.63
privacy neutrals - reward seekers 0.103 0.223 0.99 -0.52 0.72
privacy preservers - privacy ignorants 0.933 0.367 0.089 -0.09 1.95
privacy preservers - reward seekers 0.2 0.321 0.971 -0.69 1.09
privacy preservers - privacy neutrals 0.097 0.33 0.998 -0.82 1.01
reward opportunists - privacy ignorants 0.817 0.296 0.052 0.0 1.64
reward opportunists - reward seekers 0.083 0.236 0.997 -0.57 0.74
reward opportunists - privacy neutrals -0.02 0.248 1.0 -0.71 0.67
reward opportunists - privacy preservers -0.117 0.339 0.997 -1.06 0.82

Light

reward seekers - privacy ignorants 0.023 0.285 1.0 -0.77 0.81
privacy neutrals - privacy ignorants -0.044 0.296 1.0 -0.87 0.78
privacy neutrals - reward seekers -0.067 0.231 0.998 -0.71 0.57
privacy preservers - privacy ignorants 0.067 0.38 1.0 -0.99 1.12
privacy preservers - reward seekers 0.043 0.332 1.0 -0.88 0.96
privacy preservers - privacy neutrals 0.11 0.342 0.998 -0.84 1.06
reward opportunists - privacy ignorants -0.192 0.307 0.971 -1.04 0.66
reward opportunists - reward seekers -0.215 0.244 0.903 -0.89 0.46
reward opportunists - privacy neutrals -0.148 0.257 0.978 -0.86 0.57
reward opportunists - privacy preservers -0.258 0.351 0.947 -1.23 0.71

Noise

reward seekers - privacy ignorants 0.272 0.375 0.95 -0.77 1.31
privacy neutrals - privacy ignorants 0.798 0.389 0.25 -0.28 1.88
privacy neutrals - reward seekers 0.526 0.304 0.419 -0.32 1.37
privacy preservers - privacy ignorants 1.267 0.5 0.09 -0.12 2.65
privacy preservers - reward seekers 0.995 0.436 0.159 -0.22 2.2
privacy preservers - privacy neutrals 0.469 0.449 0.834 -0.78 1.71
reward opportunists - privacy ignorants 0.408 0.403 0.849 -0.71 1.53
reward opportunists - reward seekers 0.136 0.321 0.993 -0.75 1.03
reward opportunists - privacy neutrals -0.389 0.338 0.778 -1.33 0.55
reward opportunists - privacy preservers -0.858 0.461 0.344 -2.14 0.42
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Table 18: Post hoc Tukey’s range test (α = 0.05) on data collectors explaining the privacy change
when groups’ data-sharing choices are rewarded.

95% Confidence Interval
Data Sharing Criterion Sum of Squares Degrees of Freedom (df) Mean Squares F-test Significance

Data collectors

reward seekers - privacy ignorants 0.502 0.283 0.394 -0.28 1.29
privacy neutrals - privacy ignorants 0.582 0.295 0.287 -0.24 1.4
privacy neutrals - reward seekers 0.08 0.229 0.997 -0.55 0.71
privacy preservers - privacy ignorants 0.911 0.391 0.143 -0.17 2.0
privacy preservers - reward seekers 0.409 0.344 0.757 -0.54 1.36
privacy preservers - privacy neutrals 0.33 0.354 0.884 -0.65 -1.31
reward opportunists - privacy ignorants 0.967 0.305 0.017 0.12 1.81
reward opportunists - reward seekers 0.465 0.242 0.312 -0.21 1.14
reward opportunists - privacy neutrals 0.385 0.256 0.562 -0.32 1.09
reward opportunists - privacy preservers 0.056 0.363 1.0 -0.95 1.06

Corporations

reward seekers - privacy ignorants 0.286 0.343 0.92 -0.67 1.24
privacy neutrals - privacy ignorants 0.285 0.358 0.931 -0.71 1,28
privacy neutrals - reward seekers -0.001 0.277 1.0 -0.77 0.77
privacy preservers - privacy ignorants 0.433 0.459 0.879 -0.84 1.71
privacy preservers - reward seekers 0.147 0.4 0.996 -0.96 1.26
privacy preservers - privacy neutrals 0.148 0.413 0.996 -1.0 1.29
reward opportunists - privacy ignorants 0.442 0.37 0.756 -0.59 1.47
reward opportunists - reward seekers 0.156 0.293 0.984 -0.66 0.97
reward opportunists - privacy neutrals 0.157 0.311 0.987 -0.7 1.02
reward opportunists - privacy preservers 0.008 0.424 1.0 -1.17 1.18

NGOs
reward seekers - privacy ignorants 0.374 0.324 0.778 -0.53 1.27
privacy neutrals - privacy ignorants 0.607 0.338 0.382 -0.33 1.54
privacy neutrals - reward seekers 0.233 0.262 0.9 -0.49 0.96
privacy preservers - privacy ignorants 0.8 0.434 0.355 -0.4 2.0
privacy preservers - reward seekers 0.426 0.378 0.792 -0.62 1.47
privacy preservers - privacy neutrals 0.193 0.39 0.988 -0.89 1.27
reward opportunists - privacy ignorants 0.317 0.35 0.895 -0.65 1.29
reward opportunists - reward seekers -0.057 0.277 1.0 -0.83 0.71
reward opportunists - privacy neutrals -0.29 0.293 0.86 -1.1 0.52
reward opportunists - privacy preservers -0.483 0.4 0.747 -1.59 0.63

Goverments
reward seekers - privacy ignorants 0.263 0.38 0.958 -0.79 1.32
privacy neutrals - privacy ignorants 0.552 0.397 0.635 -0.55 1.65
privacy neutrals - reward seekers 0.289 0.307 0.881 -0.56 1.14
privacy preservers - privacy ignorants 0.4 0.509 0.934 -1.01 1.81
privacy preservers - reward seekers 0.137 0.443 0.998 -1.09 1.37
privacy preservers - privacy neutrals -0.152 0.457 0.997 -1.42 1.12
reward opportunists - privacy ignorants 0.375 0.41 0.891 -0.76 1.51
reward opportunists - reward seekers 0.112 0.325 0.997 -0.79 1.01
reward opportunists - privacy neutrals -0.177 0.344 0.986 -1.13 0.78
reward opportunists - privacy preservers -0.025 0.496 1.0 -1.33 1.28

Educational institutes
reward seekers - privacy ignorants 0.528 0.284 0.346 -0.26 1.32
privacy neutrals - privacy ignorants 0.237 0.296 0.93 -0.58 1.06
privacy neutrals - reward seekers -0.291 0.23 0.711 -0.93 0.35
privacy preservers - privacy ignorants 1.033 0.38 0.058 -0.02 2.09
privacy preservers - reward seekers 0.505 0.331 0.548 -0.41 1.42
privacy preservers - privacy neutrals 0.797 0.342 0.143 -0.15 1.74
reward opportunists - privacy ignorants 0.342 0.307 0.799 -0.51 1.19
reward opportunists - reward seekers -0.186 0.243 0.939 -0.86 0.49
reward opportunists - privacy neutrals 0.105 0.257 0.994 -0.61 0.82
reward opportunists - privacy preservers -0.692 0.351 0.286 -1.66 0.28
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Table 19: Post hoc Tukey’s range test (α = 0.05) on data-sharing context/purpose explaining the
privacy change when groups’ data-sharing choices are rewarded.

95% Confidence Interval
Data Sharing Criterion Sum of Squares Degrees of Freedom (df) Mean Squares F-test Significance

Context/purpose

reward seekers - privacy ignorants 0.119 0.3 0.995 -0.71 0.95
privacy neutrals - privacy ignorants 0.17 0.313 0.982 -0.7 1.04
privacy neutrals - reward seekers 0.051 0.242 1.0 -0.62 0.72
privacy preservers - privacy ignorants 0.511 0.414 0.732 -0.64 1.66
privacy preservers - reward seekers 0.392 0.364 0.819 -0.62 1.4
privacy preservers - privacy neutrals 0.341 0.375 0.893 -0.7 1.38
reward opportunists - privacy ignorants 0.317 0.323 0.864 -0.58 1.21
reward opportunists - reward seekers 0.197 0.256 0.939 -0.51 0.91
reward opportunists - privacy neutrals 0.147 0.271 0.983 -0.61 0.9
reward opportunists - privacy preservers -0.194 0.384 0.987 -1.26 0.87

Health/fitness

reward seekers - privacy ignorants 0.765 0.36 0.216 -0.23 1.76
privacy neutrals - privacy ignorants 1.064 0.375 0.042 0.02 2.1
privacy neutrals - reward seekers 0.299 0.291 0.841 -0.51 1.11
privacy preservers - privacy ignorants 0.833 0.482 0.42 -0.5 2.17
privacy preservers - reward seekers 0.068 0.419 1.0 -1.09 1.23
privacy preservers - privacy neutrals -0.231 0.433 0.984 -1.43 0.97
reward opportunists - privacy ignorants 0.925 0.388 0.128 -0.15 2.0
reward opportunists - reward seekers 0.16 0.308 0.985 -0.69 1.01
reward opportunists - privacy neutrals -0.139 0.326 0.993 -1.04 0.76
reward opportunists - privacy preservers 0.092 0.444 1.0 -1.14 1.32

Social networking

reward seekers - privacy ignorants 0.318 0.263 0.746 -0.41 1.05
privacy neutrals - privacy ignorants 0.271 0.274 0.859 -0.49 1.03
privacy neutrals - reward seekers -0.46 0.212 0.999 -0.64 0.54
privacy preservers - privacy ignorants 0.433 0.352 0.732 -0.54 1.41
privacy preservers - reward seekers 0.116 0.306 0.996 -0.73 0.96
privacy preservers - privacy neutrals 0.162 0.316 0.986 -0.71 1.04
reward opportunists - privacy ignorants 0.3 0.283 0.827 -0.49 1.09
reward opportunists - reward seekers -0.018 0.225 1.0 -0.64 0.61
reward opportunists - privacy neutrals 0.029 0.238 1.0 -0.63 0.69
reward opportunists - privacy preservers -0.133 0.324 0.994 -1.03 0.77

Environment

reward seekers - privacy ignorants 0.486 0.292 0.459 -0.32 1.29
privacy neutrals - privacy ignorants 0.657 0.304 0.202 -0.19 1.5
privacy neutrals - reward seekers 0.172 0.236 0.95 -0.48 0.83
privacy preservers - privacy ignorants 0.933 0.39 0.125 -0.15 2.02
privacy preservers - reward seekers 0.447 0.34 0.681 -0.49 1.39
privacy preservers - privacy neutrals 0.276 0.351 0.934 -0.7 1.25
reward opportunists - privacy ignorants 0.767 0.315 0.113 -0.11 1.64
reward opportunists - reward seekers 0.281 0.249 0.792 -0.41 0.97
reward opportunists - privacy neutrals 0.109 0.264 0.994 -0.62 0.84
reward opportunists - privacy preservers -0.167 0.36 0.99 -1.16 0.83

Transport

reward seekers - privacy ignorants 0.351 0.325 0.816 -0.55 1.25
privacy neutrals - privacy ignorants 0.908 0.338 0.063 -0.03 1.85
privacy neutrals - reward seekers 0.557 0.262 0.218 -0.17 1.28
privacy preservers - privacy ignorants 0.767 0.434 0.399 -0.44 1.97
privacy preservers - reward seekers 0.416 0.378 0.807 -0.63 1.46
privacy preservers - privacy neutrals -0.141 0.39 0.996 -1.22 0.94
reward opportunists - privacy ignorants 0.875 0.35 0.098 -0.1 1.85
reward opportunists - reward seekers 0.524 0.277 0.329 -0.25 1.29
reward opportunists - privacy neutrals -0.033 0.294 1.0 -0.85 0.78
reward opportunists - privacy preservers 0.108 0.401 0.999 -1.0 1.22
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